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1 Important and general information

1.1 Important information

Please follow these instructions before and during the use and application on any IPETRONIK
product!

1.1.1 Safety and Warning instructions
Please follow the instructions and information as contained in the user manual!

1. The user can influence an electronic system by applying the IPETRONIK product. This might
cause risk of personal injury or property damages.

2. The use and application of the IPETRONIK product is permitted only to qualified professional
staff, as well as, only in appropriate manner and in the designated use.

3. Before using an IPETRONIK measurement system in the vehicle it has to be verified that no
function of the vehicle, which is relevant for secure operation, might be influenced:
- by the installation of the IPETRONIK measurement system in the vehicle,
- by an potential malfunction of the IPETRONIK system during the test drive.

In order to avoid possible danger or personal injury and property damages, appropriate actions are
to be taken; such actions have to bring the entire system into a secured condition (e.g. by using a
system for emergency stop, an emergency operation, monitoring of critical values).

Please check the following points to avoid errors:

- Adaption of sensors to components of the electrical system / electronics, brake system, engine
and transmission control, chassis, body.

- Tap of one or several bus systems (CAN, LIN, ETHERNET) including the required electrical
connection(s) for data acquisition.

- Communication with the vehicle’s control units (ECUs), especially with such of the brake system
and/or of the engine and transmission control (power train control system).

- Installation of components for remote data transmission (mobiles, GSM/GPRS modems, WiFi
and Bluetooth components).

4. IPETRONIK devices are designed for applications in extended temperature ranges > 70 °C
(158 °F). A high environmental temperature and the module’s self-heating may cause burns of the
skin when touching the hot surface. In order to avoid the risk of injury we recommend to take care for
appropriate safety precautions (e.g. contact protection, covering/enclosure, warning sign, ... )..

5. Before directly or indirectly using the data acquired by an IPETRONIK measurement system to
calibrate control units, please review the data regarding to plausibility.

6. With regard to the application of IPETRONIK products in vehicles during use on public roads the
manufacturer and/or registered user of the vehicle has to ensure that all changes/modifications
have no influence concerning the license of the vehicle or its license of operation.

7. User does agree to the instructions and regulations as mentioned above. In case the user does
not agree with the instructions and regulations as mentioned above, he has to notify this expressly
and immediately in writing to IPETRONIK before confirming the sales contract.

1.1.2 Liability, Warranty, Copyright, License agreement

Please refer to http://www.ipetronik.com/en/terms-conditions for detailed contract information:

» Limitation of liability
»  Warranty
» Copyright and Duplication

» Software license agreement

IPEmotion Plugin IPETRONIK-LOG IPETRONIK GmbH & Co. KG ipetronik.com 71173
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1.2 General information

1.2.1 About this manual

The manual describes the structure of the IPEmeasue data logger devices M-LOG / M-LOG V3, S-LOG,
FLEETIog / FLEETIog2 and IPElog / IPElog2, as well as, peripheral devices and accessories components.

© 2018 All rights reserved !

IPEmotion Plugin IPETRONIK-LOG

Descriptions in this documentation refer to the current release. Please note, that the logger requires the
corresponding application software TESTdrive.

O To run this Plugln an release = IPEmotion 2017 R2 has to be installed on your computer.

IPEmotion

Contents described in this document relates to the release versions IPEmotion 06.00.00 (2016) to IPEmotion
07.02.00 (2017 R3).

IPEmotion 2017 requires Microsoft .NET 4.5.1 Framework. This version is no longer supported by Windows
XP.

1.2.2 Legend of used icons

Tip This icon indicates a useful tip that facilitates the application of the software.

O Information  This icon indicates additional information for a better understanding.

A Attention! This icon indicates important information to avoid potential error messages.
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1.2.3 New features, Changes

Please also refer to the latest release notes at:
c:\Program Files (x86)\IPETRONIK\IPEmotion Plugin IPETRONIK LOG V03.5x.xx\Help\

Plugin IPETRONIK-LOG V03.62
No. Feature

1 Bug fixing, optimizations

Plugin IPETRONIK-LOG V03.61
No. Feature

1 Bug fixing, optimizations

Plugin IPETRONIK-LOG V03.60
No. Feature
1 Plugin LOG / X in parallel

2 openABK functions

Plugin IPETRONIK-LOG V03.59

No. Feature

IPElog2 access point

IPEwifi V3

Transfer category FTP server
Transfer category LOG files
XCP: Disconnect Second Tester
ECU CCP parameters

UDS security access

0o N o o~ W N B

SFTP resume

9 Transmit traffic messages
10  IPElog2 gyro sensor

11 Data transfer parameters
12 Project properties

13  Plugin LOG / X in parallel

IPEmotion Plugin IPETRONIK-LOG

Release May 2018
Description

FlexRay Satellite according to the release notes

Release May 2018
Description

M-CNT2, M-LOG V3, CAN FD Satellite according to the release
notes

Release January 2018
Description

Activating the Plugin IPETRONIK-LOG and the Plugin
IPETRONIK-X (simultaneous operation) is supported.

Implemented functions of the logger display & control concept
openABK buttons, openABK DHCP server, openABK unique
names

Release November 2017

Description

WiFi access point support

External device for WiFi data transfer with M-LOG V3

Up to 3 categories can be assigned to an FTP server

Up to 3 categories can be assigned to the log file

Delay time after the the second tester will be disconnected
Optionally use CCP parameters from ECU

Security access for the UDS protocol

Resume is active: The data transfer will be continued where it has
been stopped with the previous transfer.

Resume inactive: A corresponding and already existing file on the
FTP server will be overwritten.

Transmit messages in traffic groups

Support of IPElog?2 internal gyro sensor

Default values for data transfer parameters have been adapted
Project properties are no longer stored in mea_conf

Plugin IPETRONIK-LOG and IPETRONIK-X activated in parallel
might cause software problems
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Plugin IPETRONIK-LOG V03.58

No.

1

10

11

12

Feature

Cisco VPN removed

SW filter frequency selection

Export of channel comments

New OBD channels
Radius calculation (polar)

Angle calculation (polar)

Calculation ISNOVSALUE
External video data storage
Sign-of-live

Measurement status file with
wake up reason

TESTdriveCmd DataTransfer

Remote2 (M-LOG V3, IPElog2)

Plugin IPETRONIK-LOG V03.57

No.

1

10
11

Feature

IPElog2 support

Quickstart data options
Available WLAN networks

New UDS super job
UDS check string

Indication of CAN/LIN bus activity

Hardware description file

Data post processing

Use last value from previous
measurement

Category overview

XCPonUDP import

IPEmotion Plugin IPETRONIK-LOG

Release February 2017
Description

Cisco VPN settings will be deleted when loading a former
configuration (GUI access no longer supported).

Software filter frequency now as drop-down menu selection

Activation at Options > Plugins > IPETRONIK LOG > IPEmotion
settings > Options > Extended > IPETRONIK CAN, default =
deactivated

Supported PIDs: 102 - 106, 108 - 110, 112 - 124, 127, 131
Radius = SQRT( "phi_y" * "phi_y" + "phi_z" * "phi_z")

Angle = IF( "phi_z" >=0; ACOS("phi_y" / "Radius" ) * 180/PI; -1 *
ACOS("phi_y" / "Radius" ) * 180/PI + 360)

ISNOVALUE (x;y), NoValue detection with delay
Storing video data on external USB medium
Connecting status between logger and web interface

New entry wake up reason:
Unknown/ Remote/ Wake On CAN/ No Message Lost/ Wake On
RTC/ Modem (SMS)/ low voltage

The new parameter ,transfer” controls the data post processing.
Depending on its status (true/ false) zipped and splitted files will
be copied to the USB stick subsequently.

2nd input in addition to the control input Remote 1 (e.g. ignition
line 15) as OR-conjunction solely supported with the
Power-IN/Remote connector of M-LOG V3 and IPElog2

Release July 2016
Description

Hardware type 10x CAN, 6x LIN, 2x ETH, WLAN
Hardware type 16x CAN, 2x ETH, WLAN

Off, During boot-up, During boot-up + Measurement Stop-Start

Cyclic SSID scan provides latest WLAN status information (logger
with built-in WLAN unit required)

PST LESEN_UDS 2
Comparing the ,SearchString“ of the UDS job and the ECUs reply

Creating status entry in Log file / Measurement status file once the
timeout delay of the respecitve CAN/LIN input expired

New backup of the HW_descr.xml prevents from illegal access

User configurable Start Delay / Retry Delay time (range 10 s ...
5 min) to trigger the parallel data post processing

Using the last value from previous measurement as start value for
a signal calculation within the current measurment

Selection list for the data transfer category

Import of A2L description files using an USB2ETH adapter

IPETRONIK GmbH & Co. KG ipetronik.com 10/ 173



Important and general information

IP=TRONIK

Plugin IPETRONIK-LOG V03.56

No.

a A W N P

(o)}

Feature

Multi CAN-Send

GPS channels added
openABK capable display
Logger status info

IPEconnect access point

J1939 extension

UDS extension Second Tester

Plugin IPETRONIK-LOG V03.55

No.

a A W N PP

(o))

10

11

12

13

14

Feature

M-LOG V3
FLEETIog2-03

IPElog 6x CAN, 6x LIN
M-VIEWfleet, scaling
USB video

Mail groups, recipients list
Serial number specific

program/configuration update
(mcf, fcf, rtb, prg)

Import of PDX files
NoValue group

Send category ,NoTransfer”
CCP, XCP second tester

CCP, XCP EPK missmatch

New parameter <meaNumber>
for TESTdriveCmd.xml

IPEconverter

IPEmotion Plugin IPETRONIK-LOG

Release April 2016

Description

CAN node supporting multiple CAN-Send blocks

GPS latitude in degrees, GPS longitude in degrees

Support of the openABK protocol V1.0 for EMBU-SYS displays
Web interface showing logger status information and signal list

IPEhub2 supports access point operation for online data
visualization with mobile devices (smartphone, tablet)

Event triggert measurement in signal mode

Configuration of an additional tester ID

Release August 2015

Description

Support of new data logger M-LOG V3

Support of FLEETlog2 with D Sub D connector (CAN, DI/O)
Data logger IPElog providing 6 CAN and 6 LIN inputs available
Multipoint scaling for M-VIEWfleet supported

- Support of multiple USB cameras via USB hub
- Support of Logitec QuickCAM VisionPro (DID 0x09A6)

Separate list of mail recipients per mail group

Verification of the logger serial number for program/configuration
update (mcf, fcf, rtb, prg). In case of missmatch, the latest valid file
is used.

One or more PDX files can be imported for each CAN node

Extended NoValue monitoring with with new data group ,NoValue
group® (Logger processing). User defined formulas for trigger
conditions are supported.

Additional send category ,NoTransfer® in order to exclude user
defined data from transfer.

Check for second tester connected to the bus before starting ECU
communication.

Selectable behaviour in case of EPK missmatch. (default setting:
proceed measurement)

The service <dataTransfer> now provides the new paramater
<meaNumber> in order to send defined mea files in advance (per
modem), instead of at the end of the test drive trip.

Refer to manual IPEconverter V03.55 for latest extensions
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Plugin IPETRONIK-LOG V03.54 Release November 2014
No. Feature Description
1 M-LOG 6 CAN Support of new M-LOG measurement interfaces
M-LOG 3 CAN /1 LIN
2 New CAN devices Support of M-SENS2 250 Hz, M-UNI2, M-THERMO2 HV,
CANpressure 150 bar
3 Diagnostic measurement Set trigger conditions to start diagnostic jobs
4 CAN Timeout value User defined value for the timeout. Without a valid signal value

after the timeout has expired, the system will indicate “NoValue”

5 DAQ polling groups (polling list)  ECU signals can be allocated to different polling groups. Up to 4
groups can be defined by user

6 Seed&Key file using the XCP Set file location for the Seed&Key file.

protocol
7 XCPonCAN extension New Protocol status channel with XCP, CCP, KWP, UDS
8 CAN-Send extensions New columns bit count and data format added
9 Statistic Group (Min/Max list) Activation of the min/max list calculation has been modified.
(STG file) Requested signals can be assigned to max number of 4 statistic
groups.
10  File transfer categories Storage, traffic and statistic groups can be asigned to a file

transfer category. Each of 3 categories can uses a data transfer
medium (LAN, WLAN or COMgate).

11  Disable USB stick data exchange Automatic data download / configuration upload can be
enabled/disabled with the Pluglin options settings.

12 Logger reset Reset the logger to factory default settings (DIN 01 = active)

13  IPEcloud Define access parameters for data download from FTP server.
Measurement data can be iported directly using IPEmotion‘s Data
manager and Analysis tools.

14 J1939 extensions Activate J1939 protocol information
DM1 messages conversion methods

15 DLM Optional path for user operations (DLM)
C:\Users\Public\Documents\IPETRONIK\IPEmotion\Custom\User
Operation

16 XCPonCAN and XCPonUDP with  30/min, 12/min, 6/min, 1/min, 2/h, 1/h
additional storage rates

15 IPElog extensions

WakeOnSMS Start IPElog per SMS from standby mode
Rescue configuration Export rescue configruation
Provider blacklist Create provider blacklist to exclude them for data transfer
16  Time zone status information Enable the use of time zone status information (UTC status) with

the Plugln options settings

17  exFAT format of the SSD card Format SSD drive using the exFAT data format which support
used with IPElog memory sizes up to 512 Terra bytes

18 S.M.AR.T. Support of Self-Monitoring, Analysis and Reporting Technology
with the appropiate storage medium
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Plugin IPETRONIK-LOG V03.54
No. Feature

19 Event based measurements in
MDF4 data format

20  Count ECU data requests

21  Mail groups

22 IPEconverter extensions
ASAM ATF/XML export
DIAdem TDM/DAT export
CSV, Excel2003/2010 export

Plugin IPETRONIK-LOG V03.53
No. Feature

1 LOG2PC (ETH communication)
IP 239.192.0.5 at port 7302

2 TESTdrive update to V03.53.xx

Plugin IPETRONIK-LOG V03.52

No. Feature

1 FLEETIlog2 support

2 CAN-Send extensions

3 J1939 extensions

4 OBD 2 extensions

5 External storage medium (USB)

6 Traffic measurement extensions

7 CAN ID assignment

8 Measurement stop with
automatic restart

9 New status signals

10 New calculation

11 Hardware license information

12 Licensing of traffic groups

IPEmotion Plugin IPETRONIK-LOG

Release November 2014 (continuation)
Description

Channels of a CAN measurement with disabled cyclic acquisition
(Event controlled) will be stored using the MDF4 format.

All ECU data requests (means successful and unsuccessful
attempts) will be logged.

Support of sending e-mails parallel to data post processing.

NoValue handling, grouping mode
new data format types
V-TAB scaling, rounded floating values

Release April 2014
Description

The UPD based protocol uses multicasts now, Firewall settings
must not refuse the use of this port/IP.

Execute inital update of the logger software by USB stick.
Following updates are supported by LOG2PC as usual.

Release December 2013
Description
Data logger FLEETIog2 is supported now

Send counter with individual settings for start bit, bit length, and
data format, Signal output with individual settings for start bit, bit
length, and data format in expert mode

J1939 protocol including DM1 signals
refer to separate documentation J1939_DM1

Single PID, status channel, trigger conditions

Selectable for signal and traffic storage groups
TESTdriveCmd.xml required

Ring buffer, Filter functions

Automatic assignment during system identification > IPEmotion
Options > Plugln specific settings

StopStart event (logger processing) stops the current
measurement and restarts immediately

Video file size, Measurement number, OBD-2 processing
INT_ADD()

Logger context menu Extras shows hardware license information
from the description file (hw_descr.xml)

License verification of storage and traffic groups
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Plugin IPETRONIK-LOG V03.51

No. Feature

1 PIN assignment

2 Traffic storage groups
3 Extension for IPElog

(requires PIC = V01.01.07,
FPGA 2 Vv01.02.08

4 CCP

5 Upload and download

6 Event controlled measurement
7 Masks

8 File name length

9 Stop date, Stop time

10 PreTriggerTime, PostTriggerTime

Plugin IPETRONIK-LOG V03.50

No. Feature
1 Notes
Version reference
SC1200
IPElog
2 Status signal "FIFO overrun”
3 Debounce time of the remote
signal
4 Extensions TESTdriveCmd.xml
5 Differnt init modes for module
initialization
6 Status e-mail with snap shot report
7 Limit display with M-VIEWvga

8 V-TABs enable clear text display

IPEmotion Plugin IPETRONIK-LOG

Release July 2013

Description

FLEETIlog and IPElog added

Traffic measurement now support different storage groups

NoMessageLost function (NML)

WakeOnCAN can be activated for each channel

up to 6 ID triggers

Logger restart using WakeOnCAN or remote signal

CAN-ID trigger now StartNotStopTrigger (instead StartOnly)
PIC update per job executable

Status indication of the flap for the storage medium with
M-VIEWfleet

Command CCP_DISCONNECT implemented
Supported with different transfer media (Modem, WiFi)

CAN data acquisition based on traffic measurement but
handled as signal measurement (DAT format)

for CAN identifiers are supported now

Up to 260 characters are allowed for file names of the external
library and configuration files.

Stored as project property with the traffic file

Supported as project property

Release October 2012

Description

Logger Plugin = 3.5x requires IPEmotion = 2.xx
M-LOG with SC1200 is no longer supported
Requires TESTdrive / Plugin IPETRONIK-LOG = 3.5x

Indicates the data processing status.
Output 0 = OK, Ouput 1 = processor overloaded

Configurable delay time within a range of O ... 5 seconds. The
signal status ist valid if the remote signal lasts for this time
without interruption.

New jobs "OnOK" and "OnError" used for audible alarm of the
job "OnConnect"

Connected IPETRONIK modules will be initialized on
command: Never, Once-only, Always.

Each time the trigger condition is fulfilled, the current signal
values (configured in the mail group) will be sent per mail.

Indication of limit violation has been revised.

Individual text can be assigned to different signal values (or
ranges) which is respectively displayed (instead of digits).

IPETRONIK GmbH & Co. KG ipetronik.com 14/ 173



Important and general information I PE TRON I K

1.2.4 Support
Headquarter:

IPETRONIK GmbH & Co. KG
Im Rollfeld 28

76532 Baden-Baden, Germany

Phone +49 7221 9922 0
Fax +49 7221 9922 100

info@ipetronik.com
www.ipetronik.com

Limited commercial partnership with its head office in Baden-Baden, registry court HRA No. 201313

IPETRONIK Verwaltungs-GmbH Baden-Baden is an individually liable society, registry court Mannheim HRB
No. 202089

CEOs: Andreas Wocke, Christian Buchholz

Technical support and product information

www.ipetronik.com e-mail: support@ipetronik.com

1.2.5 Related documentation
IPEmotion

The documentation IPEmotion.pdf provides you with a description and useful information related to
IPEmotion. This documentation is stored in the following standard language dependent directory:
C:\Programs\IPETRONIK\IPEmotion Vxx.xx.xx\Help

1.2.6 Documentation feedback

At IPETRONIK, the technical publications team strives to produce documentations of the highest quality and
values your feedback as a reader and user. If you have any comments or suggestions regarding our product
manuals, contact us under support@ipetronik.com .

When commenting on our products, please include the following information:
Version number
Name of the guide
Page number or section title

Brief description of the content (e.g. inaccurate instructions, grammatical errors, or information that
require clarification)

Any suggestions for a general documentation improvement

IPEmotion Plugin IPETRONIK-LOG IPETRONIK GmbH & Co. KG ipetronik.com 15/ 173
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2 System basics

2.1 Datalogger applications (extract)
2.1.1 Configuration, Online measurement using Ethernet

( B G

Data logger M-Modules
Calculation,
Storage

( 20
CANpressure

System configuration
Online measurement

I

Configuration » =
et (Loczec) | &
e CAN 1, CANZ, ... CANX
ata ! e
CCP, KWP, XCP, UDS i Y @ J
Vehicle (ECU)
2.1.2 Fleet data logger
GPRS, UMTS, 3G worldwide
< > 1
Internet
ETH
< Measurlng Conﬁguratlon >
data \\ e /
- l J = e
N N\ N\ w
Description files Data logger 1 Data logger 2 Data logger n
Calculation, Storage Calculation, Storage Calculation, Storage
@ @ ——
CANdb  A2L  Measuring m
plan
FlexRay: FIBEX, AUTOSAR CAN 1, CAN2, ... CANX CAN 1, CAN2, ... CAN4 CAN 1, CAN2, ... CAN 12
CCP, KWP, XCP, UDS CCP, KWP, XCP, UDS CCP, KWP, XCP, UDS
G = —J
=
Vehicle (ECU) Vehicle (ECU) Vehicle (ECU)
-
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2.2 Connecting devices via CAN bus

2.2.1 CAN bus basics

CAN-Standard

The communication of the IPETRONIK SIM and M devices takes place by using the CAN bus according to
the CAN 2.0 A (11 Bit Identifier) and CAN 2.0 B (29 Bit Identifier) specification. Each software application,
which is able to process CAN data through a suitable interface
can acquire measurement data from IPETRONIK CAN devices.

User data within the CAN message:
A CAN message can transfer 8 values in

Structure of a CAN message Byte format resp. 4 values in Word format.
: . B
g Standard Frame CAN 2.0A (11-Bit-ldentifier) E g
::SNr :: : Iderﬁifier JHH 1E?Iic 20 Mealsurement DTra // | 8x 8 Bit | . C,;RSC 929 1‘:HE(:’?F W\Eg
1!
E—; Extended Frame CAN 2.0A (29-Bit-ldentifier) E E
:::;Nr :: 1 Identifier / 115 \dquﬁer Lk %EC Melasuremenl Dlala // | 8 x 8 Bit | 104 (;II;C . 121E;)F 1”32
17
CAN 2.0A (11 Bit Identifier) CAN 2.0B (29 Bit Identifier)
Bits Description Bits Description
1 SOF Start of Frame 1 SOF Start of Frame
11 ID Identifier 11 ID Identifier
RTR Remote Transmission Request 1 SRR
IDE Identifier Extension (0) 1 IDE Identifier Extension (1)
18 ID Identifier (extended)
RTR Remote Transmission Request
1 rl
1 ro 1 ro
DLC Number of following data bytes 4 DLC Number of following data bytes
64 Data  Data bytes ——— 64 Data  Data bytes
15 CRC  Error Identification Code 15 CRC | Error Identification Code
2 ACK Acknowledge 2 ACK Acknowledge
10 EOF End of Frame, Inter frame space 10 EOFS End of Frame, Inter frame space
110 Total number of bits 130 Total number of bits
\ 4
Word  Byte Bit (Message layout in the displaying format ,,Intel Standard®)
0 0 7 6 5 4 3 2 1
1 15 14 13 12 11 10 9
1 2 23 22 21 20 19 18 17 16
3 31 30 29 28 27 26 25 24
2 4 39 38 37 36 35 34 33 32
5 47 46 45 44 43 42 41 40
3 6 55 54 53 52 51 50 49 48
7 63 62 61 60 59 58 57 56
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Access to the CAN bus, Transferring properties

The CAN bus allows a safe and effective data transfer of the connected devices (non-destructive bitwise
arbitration = resource distribution to different devices). The CAN bus is therefore used as a standard
communication medium in the automotive area and the industrial automation.

The most important characteristic CAN bus properties are:
» Every bus participant (node) can send, as well as, receive.

» First of all, the node, which wants to send, needs the authorization. All participants become
automatically a recipient (There is no abortion of the data sending process > non-destructive
collision).

» No stations are addressed but messages.
» Every message is characterized by its name (Identifier).
» The less the identifier, the higher the message priority.

» A message can transport up to 8 * 8 Bit = 64 Bit (8 Byte) user data, whereas each message
requires 110 Bit or 130 Bit (Extended ID).

» Depending on the hardware and the bus line length, up to 1 MBIt/ s can be transferred.
The following important conclusions result from the properties above:

» The less the bus load, the less the probability of a “Bus access conflict” (you can call this a real- time
capable area).

» A high bus load forces stations to loose messages with a high identifier or to send them more
slowly. Messages with a high identifier can “get lost”.

» Not sent messages are only registered by the “Recipient node” because data are missing. If no
timeout has been defined, the last valid value is generally sent, i.e. a mistakenly constant value.

Transfer rate, Bus line length

The CAN bus supports a max. transfer rate of 1 MBit/s according to Norm ISO 11898-2.
This value is limited in practice by the following points:

» the bus line length

» the branch line length to the CAN stations

» the bus lines quality and the plug contacts

» the bus line design (twisted, single or two-wire bus)
» bus connection structure and

» type and strength of external perturbations

Example
Data rate on the bus 1 MBit/s = 1 ps/Bit
Data length of a CAN message 130 Bits total
User data in a message 64 Bit = 4 values with 16 Bit resolution each
Time for a CAN message 130 Bit x 1 ps/Bit = 130 us/message
i.e. 4 values require 130 us
Calculating the total sampling rate 130 ps match 7.69 kHz
Converted to one channel 4 x 7.69 kHz = 30.76 kHz
Theoretical transfer rate 30 channels with 1 kHz = 30 kHz
Practical experiences 26 channels withl kHz = 26 kHz
(The value is lower at guaranteed synchronity.)

If CAN messages are not completely used (e.g. only three 16 bit values instead of four per message), less
data can be transferred although the sum sampling rate has not yet reached the maximum. This also applies
if different sampling rates are defined in one system, because the data division to the CAN messages is not
time-optimized (minimum time required).
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2.3 Ampacity and voltage drop

Besides the fact that the max. bus line length is defined by the desired data transfer rate, the ampacity and
the voltage drop in the system have primarily to be checked. This is especially important for systems with a
high number of devices and/or long connections lines of the devices (e.g. distributed systems with
connection lines of 3 m (9.84 ft) and more between the device groups). Additional actions should be taken
accordingly to the situation.

2.3.1 Ampacity

The maximum current via the M-CAN system cables (e.g. 620-560.xxx) is 4 A (heat generation by transition
resistances of the plug contacts).

The system capacity and therefore the power consumption can approximately be calculated by using the
number of devices (including the sensor supply). A direct power acquisition in the real system provides exact
values.

We recommend one or several of the following actions if the limit value is exceeded:

» Increasing the supply voltage of the devices (e.g. 24 V DC power supply or 42 V DC
instead of 12 V)

» Centered voltage supply via T connection or as close as possible to the devices with high
power requirements (rather than at the beginning or end of the system chain)

» Additional system supply via a T connection at a suitable position

2.3.2 Voltage drop

Even if the limit value for the ampacity is not reached, long lines in an extensive system can cause
perturbations in the acquisition process. This mainly applies to devices at the end of the system chain,
because the voltage of the last devices does not exceed the input threshold of 9 V (due to a high voltage
drop in the system).

We recommend one or several of the actions mentioned above.

The voltage drop can be calculated by using the following formula:

U=Rx
R = 2 X Rcable [ovm] X Lengthcabie [m]

| = Ppevices W] | Upevices [V]

For estimating the voltage drop, a resistance of

> 50 mQ/m for the M-CAN cables and
> 35 mQ/m for the SIM-CAN cables

can be used including the transition resistances of the plug contacts. Systems, which are in the limit range of
the voltage drop, should be controlled in individual cases. To do so, our support will be pleased to assist you.

As the power consumption of a device depends on the supply voltage, it is useful to calculate the voltage
drop from the chain end to the feeding point. In this case, a minimum voltage of 9 V is set to the last device
and the required excitation is calculated. The calculated value should be generously rounded upwards for
guaranteeing a safe operation.

Another fact is the variable internal resistance of the input power supplies (low excitation = lower internal
resistance).

In practice, this means: If the net excitation decreases (e.g. because of a weak power supply or a high
resistivity with long cables), the devices have to readjust to cover the current power requirements. This
causes a higher power consumption, which additionally increases the voltage drop.
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3 Datalogger M-LOG, S-LOG, FLEETIog/FLEETIog2, IPElog

Data logger M-LOG, S-LOG, FLEETIog/FLEETIlog2, IPElog

3.1 Overview

(
Device IPElog2 IPElog M-LOG V3 FLEETlog2 IPEhub2
Operating system RTOS 32 (32 bit) RTOS 32 (32 hit) RTOS 32 (32 bit) RTOS 32 (32 bit) Linux (32 bit)
Processor Intel ATOM T3805 Intel ATOM T3805 Intel ATOM T3805 X800 Arm
RAM memory 2GB 2GB 2GB 256 MB 2564 MB
Data loggars software TESTdrive TESTdrive TESTdrive TESTdrive IPERub
Removable storage madium cFast 550 ckast CF 5D
Storage capacity 8/ 16/ 32/ 64 o 16/;82/ o 8/ 16/ 327 64 8/ 16/ 32 1/2/4/8
Scftware
Configuration software IPEmction IPEmation IPEmction IPEmation IPEmation
Mo Massage Lost (NML) | | | |
Wake on CAN (WoC) ] ] [ ] ]
Wake on LIN (Wol) [ ]
Wake on FlexRay (WaFR)
Wake on SMS (WoSMS)
Wake on Real Time (WoRTC)
On board scripting
On board math & logic
. ] ] ] ]
operations
File formats for data storage DAT, BIN, AV, DAT, BIM, AV, DAT, BIM, A¥l, DAT, BIM, AV, HRD
WAY, MDF4.1 WaAY, MDF4.1 WAV, MDF4.1 WAY, MDF4 1
Interfaces
Ethernet interface to PC 1 GigETH 100 Mbit 100 Mbit 100 Mbit 100 Mbit
LUSE 2.0 ports 2 2 2 2
USB 3.0 ports
Lemo, S-pin for M-CAN 1 1 5 1 1
modules
CAM HS (150 11898-2) [ | [ ]
CAN LS (Low Speed)
CAM FD
LIN(1.3& 2.0 1.6 1.4
ETH (100 Mbit) 1 2 2
ETH {1 GigETH) 1
FlexRay 1 (By extender) 1 (By extender) 1 (By extender)
Digital [/ 4/4 4/4 4/4 2/2
COM (sarial R3232) 1 2

Audio input / output

1

IPEmotion Plugin IPETRONIK-LOG

1
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Device

Driver display system

Interface option 1

Interface option 2

Interface option 3
Interface option 4

Interface option 5

Extender boxes

Protocols and traffic
CCP J/ XCP an CAN
11939

GM-LAN

OBD

WWH-0BD

KW on CAN

ups / QDX / FDX
KCPanETH

FlexRay / XCP on FlexRay
MOST (25 7 150)
openABK

SOME IP

FlexRay traffic

CAN traffic

LIN traffic

CAN traffic send
Wireless communication
GNSS (Global Navigation
Satellite System)

Gyro sensor
Wik

Modem

VPN tunnel

IPEcloud / FTP servaer
Video

IP-Camera (RTSP protocol)

USB Video Class (UVC)

IPElog?

IPEmation app /
openABi
10 CAN + 6 LIN +
2 ETH
16 CAN + 2 ETH

FlexRay-Extender

20 Hz (GPS)

100 Hz
2.4 GHz
WIFI 80211 b/g)
3G (UMTS/ HSDPA)

IPEmotion Plugin IPETRONIK-LOG

IPElog

[PEmotion app /
openABK

12 CAN + Z ETH

FlexRay-Extender

1 Hz (GFS)

24 GHz
[WiFi 802.11 b/ g)
3G (UMTS)

M-LOG V3

IPEmotion app /
openABK

12 CAN

8 CAN+ 4 LIN

8 CAN+ Z ETH

& CAN+ ZLIN+
2 ETH

4 CAN + 2 ETH

FlexRay-Extender ,
COMgate V3,
IPEwiFi

1 Hz (GPS)

via COMgate V3

via COMgate V3
via COMgate V3
u

IPETRONIK GmbH & Co. KG

FLEETIog2 IPEhub:2

IPEmation app /
o IPEmotion app

opanABK
4 CAN 2 GAN
]
|
|
]
|
|
]
|
|
| |
] ]
1 Hz (GP3)
2.4 GHz 2.4 GHz
(WiFi 80217 b/g) (WiFi 80217 (b/g)
3G (UMTS)
|
]
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Data transfer range of built-in modems (FLEETIog, IPElog)
Frequency range Quad-Band EGSM 850/ 900/ 1800 / 1900
Download rate HSDPA 7,2 Mbps

UMTS/HSDPA (WCDMA/FDD) 2100 MHz

GPRS multi-slot class 12

Edge multi-slot class 12

3.2 Hardware
3.2.1 Block diagram

The block diagram shows the basic structure of the logger board.

G429\ N IModem-PWR >
b=
Temgeratur -~
__ REMOTES,| — I >
Super — GPS-PWR L
10 =] -
Realtima 12C Bus m COM 1
[[Reatime | [ 2ce | e
COM 2
| COM2
FLASH LPC X86 UART ]*Il AN ALAN
| AN AN -
oo L0
PCI (32 Bit/33MHz) 4 USE Keyboard
UsB USB Stick
e
USs Stk
Slot 1 Slot 2 Slot 3 FLASH
VGA
o CHNT * 1 X-Board
5 <
o CHN2 I DIG OUT 0-3
- e 0] L
< CHNE & . @bﬁ
CHN 4 T w 8 8 ¢ DIGINC-3
- o ™S <
w_ CHN 58 (optional) + - MIC -
- + oF Sound Headset >
- Ethemet (optional) FLASH
T M-LOG

3.2.2 Enclosure types

e Y e

FLEETIlog2

M-LOG PRO0O8

M-LOG with port replicator PR0O5 S-LOG front view FLEETIlog front and rear view

IPEmotion Plugin IPETRONIK-LOG IPETRONIK GmbH & Co. KG ipetronik.com 22/ 173



Data logger M-LOG, S-LOG, FLEETIlog/FLEETIlog2, IPElog I PE TRON I K

The M-LOG enclosure is compatible to all M devices. The devices can be easily connected with each other
with a dovetail adapter. M-LOG is available with 6 different port replicators (cable connecting adapter). User
specific port replicators are available on request.

The FLEETIlog2 hardware concept was designed for using the data logger in vehicle fleets, whereas
FLEETIlog2 WAN is already equipped with modem, WiFi client, and GPS receiver.

3.2.3 Port replicators and cables

Various cables are available for every port replicator. The complete
PIN configuration, as well as, the appropriate cables of the PR05 and
PRO08 port replicators are shown in the appendix.

3.2.4 Device panel for changing the internal memory card

S-LOG and M-LOG (M-LOG with Upgrade Kit 300) offer a screwed panel for exchanging the cF memory
card if required.

The FLEETIlog is equipped with a cF card slot behind the folding front panel.

IPElog has a screwless fixed front panel with open/close contact for exchanging the SSD memory card.

possible intrusion of foreign material, dirt or water into the device and the logger could be
damaged at removing the cF card. The regular data transfer should be done with the USB stick
or the wireless connection (modem or WiFi option).

fi Please note the advice to only change the memory card in exceptional cases because of a

3.2.5 External fuse for logger protection (IPElog, M-/S-LOG, FLEETIlog)

Depending on the number of inputs, capacitor charge, and connected devices (M or SIM
devices, Modem, GPS receiver), the total power consumption (especially at temperatures of —
40 °C / -40 °F) can reach up to approx. 150 Watt. To protect the total system, we recommend
an external overload protection with the following tasks:

» Protection of the supply line in error case
» Overload protection of the current source
» Logger protection.

We recommend using a LittleFuse ATO Fuse Fast Acting Type with a nominal current of 10 A. At using
the maximum charge in ambient temperatures under —40 °C / -40 °F, it can be required to increase the
nominal current to 15 A.

The individual electric circuits (also see M-LOG Port replicators, S-LOG = PRO05) are internally
protected. The internal resistance of multifuse types increases exponentially and limits the

= current to a minimum. After clearing the cause of error, the resistance decreases to the normal
value (automatic resetting).

The motherboard fuse does not work reversibly and must be replaced in the case of a required
repair.
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3.2.6 Additional short-circuit protection for IPElog and FLEETIog

As the M-CAN connection is not fused by the logger, we recommend to use the cable M-CAN Cable
M-CAN/PWR-Fuse (No. 620-677.xxx) in order to prevent the logger from damage caused by a short circuit.

5 Aregular ATO fuse

M-CAN-Fuse
620-677.

XXX = Length (dm)

3.2.7 LED status display (flashing codes)

LED display

YELLOW

Mode

Ready or
operating

Warning |
Low voltage

Warning Il
Low voltage

Measurement
running

Data medium
access
(post processing)

Data transfer

Error,
Emergency
operation

3.2.8 Power-down at excitation loss

M-LOG, S-LOG, FLEETIlog and IPElog are equipped with high-powered capacitors, which guarantee a short
excitation in the case of an excitation loss for regularly shutting the system down without data loss. The
storage capacity of the capacitors depends on several points (e.g. ambient temperature, aging, charge
condition). A data loss can therefore not completely be excluded in the case of a total excitation loss.

M or SIM devices, which are supplied by M-/S-LOG, FLEETIlog C2 or IPElog, are immediately switched-off at

excitation loss.

Meaning

Device is ready
(Operation: see yellow LED)

The excitation is between 6 V and 9 V. M-
LOG shuts down after 2 minutes at
unchanged status.

The excitation is under 6 V. M-LOG is
buffered by the internal supply and normally
shuts down.

The logger writes the data to the internal
memory.

Prepare file transfer (zip, split)

Transfer files via USB, modem, or WiFi

e.g. at invalid configuration, at less memory
capacity, at emergency shut-down due to
less excitation

A restart is required..

We recommend to revise the switching and the buffer capacitors every 2 years for guaranteeing
a clean functionality. The device calibration every 2 years includes this revision.
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3.3 Initial start-up

3.3.1 Connecting the logger

» Connect the red socket using the
Power/Remote cable (e.g. 620-574.xxx)
with an appropriate power supply

M-LOG PRO5, PRO8

Uidi§

— 7

ETH 620-591.xxx

(9 Voc ... 36 Voc) —
PWR+ = Voltage supply Plus = o PUR 62057420%
GND = Voltage supply Minus Shield .
Shield = Shield or voltage supply Minus
FLEETlog C2
» Connect the white socket using the E [~
LAN cable (e.g. 620-591.xxx) with the ETH 620.501000
Ethernet interface of a PCs/Notebook, : T_ -
resp. using the LAN cable GND PUR 6205743006
(e.g. 620-355.xx) for connection to - N

a network.

» Switch on the logger
REM = Ignition line 15 or power supply Plus via switch
— green status LED lights continuously

» Logger starts up and will enter the measurement mode after a short time.
— yellow status LED lights continuously

» Referto the Flow chart of the measuring
process in the appendix for more details.

PWR+ o .

GND PWR 620574000

REM . T —
Shield .. T

ETH 620-591.xxx

ln ———— -

IPElog

PWR+

GND o PWR 620-574.xxx
REM .. —6-5!-—-,
Shield ...

Useful notes

If the Ethernet connection to the logger will not work properly, at first transfer the correct IP settings to
the logger using an USB stick. Refer to Add logger system, creating test configuration (USB stick).

Using the cable 620-591.xxx LOG Cable ETHERNET (crosslink) is a point-to-point connection
between logger and PC. A fixed IP address is required for both. Refer to Static and dynamic IP
addresses.

When connecting the logger and the PC used for configuration and data acquisition to a network with
DHCP server, both have to be set to dynamic IP address, in order to receive the individual IP address by
the DHCP server automatically.

In this case use cable 620-355.xxx M-LOG PRO5 ETH Cable RJ45.

Please consider the risk of IP conflicts (same IP address may exist twice), if you use static IP address
settings when connected to a network with DHCP support.
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3.3.2 Detecting the logger, creating test configuration (Ethernet)

» Start IPEmotion at your PC/Notebook.

L e @ s IPEmation
Using Logger Plugln version = 3.50, IPEmotion = 2.0 is required. N ———
Options
4 S,ho'n'feditgeneragfimoﬁon options -
»  Activate the Plugin IPETRONIK-LOG. Detect iteize  Startdsplayng
Access
Options > Plugins > IPETRONIK LOG
The Plugin IPETRONIK-LOG version 3.50 | © Feremenestons &
and higher requires TESTdrive = 3.50 on ;:E“::;:::Ed active Tite Version Descrption Marufacturer
the Iogger. Please update the Iogger rop O —: IPEI'RONIKC.AN 01.07.00 . cOnnacﬁonoHpErRomn.mm acquisition... | IPETRONIK
. g . Dtn e O | & |IPETRONIKX 01.03.02.16363 | [PETRONIK Ethernet devices IPETRONIK
application if necessary! o’ e - = v =
B -R‘ ADVANTECH 01.00.00.20913 | ADVANTECH bus coupler IPETRONIK
Analysis O B |CAN-Send 01.00.01 CAN-Send with IPETRONIK CAN server IPETRONIK
Directories O | @ |can-acquiition D1.05.00.26052 | CAN-Acquisition with IPETRONIK CAN-Ser... | IPETRONIK
Units O & |cANprotacols 01.01.01 CAN protocol acquisition with any CAN ha... IPETRONIK
Hotkey (] ) |ETH 01.00.00.23897 | UDP or TCP socket connection IPETRONIK
User administration
Pluglns
Download
» Select the main tab Signals . Specfy e g be sed, ]

The used plugin version can be changed within the list. If a version number is selected that ends with a '=' character,
no automatic update is run at installing later plugin versions. —

OK Cancel

» Click Detect to identify the connected

hardware components. -
cQ @lm +

The / all available logger(s) will be displayed in a select list.
Confirm your selection by activating the corresponding checkbox and

s Reporting Scripting Info

click OK. The configuration settings stored on the logger will be readout ﬁ "’j}
and dISp|ayed Detect Initialize
I} Arcess
» Activate the status signal [ EEEEE Caaci 250 s Sans T Pemotion |- =) [l
CPU Ioad_ Project | Signals | Acquisiton View Datamanager  Analysis Reporting Scripting  Info @
v 5d e Fes & > ]
> Mark the lOQQer at tdhe Ieffl hsnd Add system  Add ::":2'5"5- Import Export Check Adjustment D;be;t Ini‘h:alize Start displaying Details
structure top area and scroll the : ) ) ) ) ) )
. . Configuratio Access Wiew
signal list downwards to CPU load, - - =
) V03.50.00 Hame Active | Unit | PhysMin | Phys Max | Sensor Min | Sensor Max | Sampling
hook Active to enable the . T= e
checkbox. 43 Red LED = 0 1 0 1 H
Project settings 0 e O 0 1 0 1 -
_:1 Ei: g; g Remote 01 O 0 1 0 1 H
J B o Remate 02 O 0 1 0 1 H E
» Select ETH from the left hand a CAND g || |whkeoncan | O 0 1 0 1 H
tree structure, right click and o oo A0 Iy - S
Sa DOUT 4 Uptime: O s 0,000 429496... |0 4294967,295 | 1 Hz -
choose > Add components J u= i = = 3
> XCP service from the ConteXt “ 4 $EFHX.CP o ? General  Extended | System activated | Data manager
menu T  DAQlistslow 1 Active:
{;j DAQ list medium 1]
. P e MName: |30001707
» Select DAQ list slow from the W DAQistfst 0 _ : :
. . COM-1 0 Description:  |Ultra-compact modular data logger with 4 CAM interfaces
left hand tree structure, right click B come o ——
and choose > Add components e ’
> Ch annels fl‘0m the ConteX'[ menu Fl @ Logger processing 11
iy Status 11
» Mark CPU load and confirm 8  storegegaes i
by CliCking OK. _ System status [

» Mark the logger from the left hand
tree structure top area. Click Start displaying from the tool bar.

» Once the logger has been initialized, the current value of the CPU load is displayed continuously in the
signal list. Now logger's ETH communication test and online data streaming via XCP service has been
completed succesfully.
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3.3.3 Add logger system, creating test configuration (USB stick)

In case the data acquisition or the Ethernet connection is not working properly (e.g. when using obsolete /
former configurations, incompatible IP address settings, ...), we recommend to transfer a valid (already
succefully tested configuration) per USB stick to the logger.

pal=1=E = e e 2B N el v IPEmction A=y X
} Create a |Ogger System Project | Signals | Acguisiton  View Data manager  Analysis  Reporting Scnpﬁng.:blnfo 7]
Select from the main tabs Signals “a [ g L ~ » > —
> Add System > eg M_LOG Adds}rsh&m Add ::“::-'5-":- Imenrt Exenrt Check Ad_]us-n'nent Det':ect Inlh‘ahze Start displaying Details
(4 CA N) Configuration Access View
03.50.00 Mame Active Unit | PhysMin | Phys Max | Sensor Min | Sensor Max | Sampling rate
» Enter the front number of the e s 5 ! ; =1
Iogger you will use: -l '5"3- DIN 01 0 1 0 1 10 Hz
Project settings 0
> Mark the logger at the left hand L, o 7 g . : . : -
structure top area and choose the b cano2 Ol o4 04 5 5 5 5 o
»  CANO3 0 o
Extended tab to set the last four cANO of jpoure: | O 0 : 0 : 10+
- . . @ py 4 DOUT 02 (] [1} 1 1} 1 10 Hz
digits of the logger's serial number & oo = - L -
USIng the field Front number. 4 ;513 g General | Extended | System activated | Datamanager
» Select the Data manager tab — - Front number: ‘g’
and activate the check box & udo o TESTve version: -[T;"H —_—
. Eh_ D |a‘r‘ 0 Append\x: e 135 or QIS O 12 Jevice serial numper
Updat_e connection parameters 4B ome processho =
and click to Configuration by s 1
@ Storage groups 0
»  Enter valid settings for the IP B o ’
alculations 0
address used for the Ethernet
connection (auto IP or fixed IP) as System status [

described at Static and dynamic
IP addresses.

» Create a test configuration.
» Save the current configuration settings in the project (*.icf).

» Export the project as measurement configuration (TSTdrive.mcf) to
an individual subdirectory located on your Notebook/PC or direct to an
USB stick.

» Unplug the USB stick from the configuration PC.
»  Switch on the logger.

» Plug in the USB stick while the logger is running in measurement mode (yellow LED lights). The logger

will stop measurement an start data postprocessing, existing data will be moved to the USB stick. This
process lasts as long as the yellow LED is flashing.

» Then the logger will search for a new measurement configuration on the USB C\

J

stick. If a new configruation is found, the application on the logger will be updated
and the origin TSTdrive.mcf on the USB stick is deleted.

-
E

»  Wait until the yellow LED lights nor flashes not any longer and unplug the
stick. The logger will switch to measurement operation again.

After all necessary connection parameters have been updated with valid settings (logger, PC), a
communication via the LAN cable is supported, including these actions:

» transfer a new configuration to the logger,
» detect the logger and read the configuration from the logger,

» transfer measurement data from the logger to the PC (import measurement files).
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3.3.4 Static and dynamic IP addresses

Basically IPETRONIK data loggers can be connected to other network clients via Ethernet in two different

ways:

» Point to point connection between the logger and the PC/Notebook.
Usually neither the logger nor the PC/Notebook supports DHCP (Dynamic Host Configuration Protocol),
it is necessary to set a fixed IP address for both.

» Client to client connection between logger and PC/Notebook through a local network. In this case the
network server provides DHCP and manages the automatic IP address assignment to all network clients.
Therefore logger and PC have to use dynamic IP address settings.

Use the Data manager tab to enter
the settings for the logger:

» Mark the logger at the left hand
tree structure top area.

» Select the Data manager tab
from the right hand down area
(configuration tabs).and activate
the check box Update
connection parameters.

» Click Configuration.

» Choose the tab Medium
selection and activate LAN.

» Refer to the dialogs below
for dynamic (Get IP address
automatically) and static IP
address settings.

» When using the static IP address

with the logger, it is necessary to
adapt the system control settings
of the PC/Notebook,

For example:
IP address: 192.168.0.100
Subnet mask:255.255.255.0

P2 Data transfer configuration: 80001707

General | Medium selection | LAN

Get IP address automatically: %
IF address: |0.0.0

Sub net mask:
Standard gateway:
Preferred DNS server: |0.0.0.0
Alternative DNS server: (0.0.0.0

Speed and duplex mode: | Auto

Import Export Ok

Settings for dynamic IP address

IPEmotion Plugin IPETRONIK-LOG

Py A e D = Bl 2 Xgd Gy el T PEmotion = | B
Project | Signals | Acguisiion  View Datamanager  Analysis  Reporting  Scriptng  Info 7]
Wi e b
] @ e e A ® : =
Add system  Add components  Import Export Check  Adjustment Detect Initialize Start displaying Details
Configuration Access View
03.50.00 Name Active Unit | Phys Min | Phys Max | Sensor Min | Sensor Max | Sampling rate o
Name z e L
4 % DIND1 1
Project settings Ol ooz 0 1 0 1 10 Hz
—— g DIN 03 O 0 1 0 1 10Hz
i CAN 02 0
s CAND3 il DIN 04 (] 0 1 0 1 10Hz
A canios o poutor | O ] 1 ] 1 10Hz
&= o 4| |DouTO2 [} 0 1 0 1 10 Hz
Sa bour 4 DOUT 03 O 0 1 0 1 1Hz -
g us 0
=T o General | Extended | System activated | Data manager
8 comt 1] Update connection parameters: Configuration
8 comz 0
Compress files:
#  Audio 0 Ilmpart updated connection parameters into logger configuration
\:h_ Display g/ Take configuration into measuring file: [er
= @' Logger processing 1 Take log file into measuring file: []
e Status 11 .
@ Storage groups 0 Postprocessing during acquisition: []
@ Mail groups ] Data interface: LA
@ Caleulations [1} Fi
System status \z‘
P Data transfer configuration: 80001707 | = (= [[ES
General | Medium selection | LAN
LAN:
Modem: [
COMgate:
Import Export QK Cancel
— = E 1P Data transfer configuration: 80001707 = || = E
General | Medium selection = LAM
Get IP address automatically: [
IP address: |192.168.0,101
Sub net mask: |255.255.255.0
Standard gateway: [0.0.0.0
Preferred DNS server: |0.0.0.0
Alternative DNS server: (0.0.0.0
- Speed and duplex mode: |Auto -
Cancel Import Export oK Cancel
Settings for static IP address
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3.3.5 Logger web interface for status and signal monitoring

IP=TRONIK

ETH 620-591.xxx

PWR 620-574.xxx

Signals
a i N
Label « Value ¢ Unit ¢ Comment
The logger service web site provides status information, st e °
the log file and a listing of all measured signals. TEIEAL 2802215 e
An extra configuration by IPEmotion is not necessary. 579001993 T 21739223 c
To start the site web just enter the logger IP address in 57900199 4T 20975509 c

the URL command line. The individual IP address of the
logger is available from the ETH interface settings in the
system structure of the logger configuration

57900199 5T 21.433738 C

579001996 T NoValue c

Please also refer to Fehler! Verweisquelle konnte nicht gefunden werden. Fehler! Verweisquelle konnte nicht
gefunden werden.

Using the logger system with IPEhub2 and a mobile device (smartphone, tablet) or PC with WiFi port, a
wireless access to the status web site and a user specific measurement data visualization is supported.

Refer to 9.2 IPEconnect (Online display with Smartphone or tablet) for details
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3.3.6 Logger system with CAN modules

All IPETRONIK CAN modules (M-Series, SIM-Series, CANpressure, MultiDAQ, High Voltage Iso DAQ ...)
are connected to the data logger with corresponding system cables.

Connecting the modules

» Daisy-chain the modules among one another
and connect the system with its
respective cable to the logger.

» The end of the module chain has to - M-LOG PRO5, PRO8
be terminated with a termination e 2=
plug.

» Using M-LOG or S-LOG the 2nd
CAN bus socket has to be
terminated also
> use M-CAN or SIM-CAN
termination plug.

7t M-CANterm

M-CAN 620-560.Xxxx

FLEETlog C2

M-CAN term 620-429.xxx A

M-CAN/SIM-CAN 620-562xxx

7WFB M-CAN term

M-CAN term 620-429.xxx

SIM-CAN term

Usually all IPETRONIK CAN modules are connected to the logger through the system

¢/ connectors M-CAN resp. SIM-CAN with S-LOG. Thus they can be detected and configured by
= IPEmotion in a user-friendly way. Besides this, it is also possible to connect IPETRONK
modules, as well as, non-IPETRONIK CAN modules to a free CAN measurement input.
Please note, that you need a separate cable to supply the modules with power for this.
Configuration of the modules is done manually or by importing a CANdDb file.
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Detecting modules, creating test configuration

V03.50.00 1. Select the CAN input to which the devices are
MName = connected to (CAN 01 is recommended because
4 =5 30001707 19 it is connected with the M-CAN or SIM-CAN
Project settings a socket at the |Ogger)-
Sl 2. Select Extras from the context menu (right
canoz| @B Add components » 0 mouse button).

3. Select Detection to detect the connected

@] CANDOS| @ Change into 3 0 - -
CAN 04 - o devices and to transfer the current settings to the
@= N . Exuas g ﬁ) Detection t Configuration.
- L Import P | & Extended ti . ] i
g == o R P | MultiDAQ s detected as IPETRONIK CAN device
‘ ] Exort a from TESTdrive V03.22!

» Execute Detection of connected modules as described.

» Configure the modules and the logger (activate channels, set signal
scaling, select sample rates, create storage groups, ...)

» Save the current project.

» Initialize the Logger (working Ethernet connection required) or
transfer the configuration per USB stick to the logger.

To display measurement data acquired by the logger using the Ethernet connection, you have

to add an XCP service at first. Assign all signals to the DAQ lists of the XCP service which you
= want to be displayed.

The Options setting Automatic service administration will automatically create an XCP

service and assign all active signals to the DAQ lists.

3.3.7 Access to data stored on the logger
The logger stores all data in a Zip archive on internal storage medium (cF card, resp. SD card with IPElog).
MEA_XXxX.zip measurement data + header file + current configuration

LOG_xxxx.zip logfile with status reports of the data acquisition

A measurement file (archiv file) is empty, if the sum of the file contents calculated from the files
listed below is 0. In this case, the respecitve zip archive will be deleted.

= - all files containing storage groups except the DAT files
- all trace files (BD...)
- all statistic files except the DAT files
- Min/Max statistic file (STG)
- Audio/Video files except the DAT files (AVI,WAV,IMG)
- Traffic files (BIN, Quickstart)
- LOG file
- Measurement status file
- PPP debug file (PPP...)

Access (= data transfer to a PC or FTP server) to data stored on the logger is supported:
» per USB stick
» through an Ethernet cable connection
» using COMgate or an internal/external WiFi client

» using COMgate WAN or an internal/external modem
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Using a LAN cable connection

Import measurement files / log files

e

- | [CH = L - &= L] [ . LN I E . . .
PelHEoms B e X X G el 1. Select Signals navigation tab.
Project | Signals Acqguisition View  Data manager Analysis Reporting 2. (S)\?éer\(/:itel\(l)vgger in the left Systems
—— 3. Transfer the current data (internal
.a + 5 | 5 memory) in the Signals navigation tab to
Add system  Add componentz | Import| Export Check  Adjustment Detect 4 ?gxﬁgrltn;g%ﬁr;medﬁ:r(Tth]eerr;tarlrLsgmow
~ N + pre-/post-trigger data)) in the Signals
- @ TEESE_E;ET::FEDEL?;E,SEM - navigation tab to PC with Import >
V03.50.00 Phys Measurement files (incl. ring buffer).
. ) 5. Transfer the current TESTdrive log files in
[ang Eﬂi 2 BT [":Cl' LIy the Signals navigation tab to PC with
TESTdrive Measurement files (including N
d ring buffer) ) 1 Import > Log files.
Project settings Log files 7 6. Select the target directory or crate a new
wl  CAND1 E) TESTdrive log Fles . folder to save the respective data.
CAN 02
w  CANO3 o DI E i) 1

With USB stick

Plug in the USB stick to the running logger. The logger stops data acquisition, saves data, log files and the
related configuration to the stick. If the yellow LED is not permanently on, disconnect the USB stick. The
logger runs now in acquisition mode..

Please note that data can only be imported via USB if no LAN connection to the logger is
activated. Disconnect the logger with the logger context menu.

Connect

Disconnect

© ¥

3.3.8 Synchronizing the logger time
*  Acquisition start

» Mark the logger at the left hand structure top area. m) | Acquisition stop

» Right click to the logger entry and select [ Hardware and license information

Extras > Synchronize logger time from the context menu. - :
Synchronize logger time I}

<, Extended properties

Time data of time stamp and log messages have been normalized. Now time stamp output is
local time (former UTC). Time stamps reported in XML files always indicate the offset (time lag)
= to UTC time, e.g. <startdate>2012-04-25T09:30:10+01:00</startdate>

In order to ensure a correct time interpretation of recorded data, the IPETRONIK data converter
IPEconverter V02.13 is required.

3.3.9 Readout Hardware and license information
Using the Ethernet connection (LOG2PC)

» Select the data logger on the top left area.

» Select Extras > Hardware and license information from the context menu by right-clicking.

Hardware and license information file (hw_descr.xml)

» Select the data logger on the top left area.

IPEmotion Plugin IPETRONIK-LOG IPETRONIK GmbH & Co. KG ipetronik.com 32/ 173



Data logger M-LOG, S-LOG, FLEETIlog/FLEETIlog2, IPElog I PE TRON I K

3 Select Extras > Hardware and license information from file from the context menu by
right-clicking.
» Look for the file hw_descr.xml locally or on a USB stick.

Plug a USB stick into the running data logger to retrieve the license file (together with
configuration and acquisition data). Unplug the USB stick from the logger and plug it into a PC.

= Go to the directory named with the logger’s serial number, then go to the DEVICE subdirectory.
The zip file TSTdrive contains the hardware/license file hw_descr.xml.

3.3.10 Updating the measurement application (TESTdrive) per USB stick

Measurement application TESTdrive

» Copy the file MLogger.rtb (standard, inclosed in the TESTdrive_xxx.zip) or Logger.prg (for M-
VIEWQgraph, inclosed in the Setup_xxx.exe of the respective Plugin) to the subdirectory named with the
logger's serial number on the USB stick.

» Power up the logger and wait for the yellow LED which indicates data acqusition.
» Plug in the USB stick to the logger, program update will start automatically.

»  Wait until the yellow LED lights no longer and unplug the USB.
The logger executes a reboot and starts measuring operation with the new application.

Measurement configuration (logger specific)

» Copy the file TSTdrive.mcf to the subdirectory named with the logger's serial number on the USB
stick.

» Power up the logger and wait for the yellow LED which indicates data acqusition.

» Plug in the USB stick to the logger, configuration update will start automatically. As soon as the update
has been completed successfully, the TSTdrive.mcf will be deleted from the USB stick.

»  Wait until the yellow LED lights no longer and unplug the USB.

Measurement configuration (single USB stick used for different loggers)
» Copy the file TSTdrive.mcf to the root directory on the USB stick.
» Power up the logger and wait for the yellow LED which indicates data acqusition.

» Plug in the USB stick to the logger, configuration update will start automatically. The TSTdrive.mcf will
remain on the USB stick, whether the update has been completed successfully or not.

» Wait until the yellow LED lights no longer and unplug the USB.

» Repeat this procedure for any other logger update relating to this configuration

Serial number specific update

When updating via USB/FTP, the system checks, if the file name consists of a 8 digit serial number. Update
is executed when the serial number matches with the logger, the file is deleted from the source directory
afterwards. In case of missmatch, the latest valid file is used. Files with invalid serial numbers will remain in

the source directory.
When the file contains no serial number information, the standard update process is executed (equal to
previous TESTdrive versions).
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3.3.11 TESTdriveCMD.xml

The file TESTdriveCMD.xml controls user access of the logger. If the restriction has been activated, the
logger searches for the TESTdrivecmd.xml at the root directory of the USB stick. Measurement will not be
started when the file is missing.

Activate the use of the TESTdrive commands at IPEmotion Options > Plugins > IPETRONIK LOG >

Settings e > Options > Activate TESTdrive access restriction.
The following templates are located at:

..AIPETRONIK\IPEmotion Plugln IPETRONIK {#= IPEmotion settings - IPETRONIK LOG
LOGVO03.xx.00\Data\TESTdriveCMD\[language]
Options | Components

Guest (directory ,,guest*)
General

4 Copy data Activate TESTdrive access restriction:
» External Storage Encoding of the configuration files: O
User (directory ,,user“) Encoding password: | FEEEEeEs

» Update measurement configuration SELJiEssE i O

. . Complete syste figuration files:
» Update measurement configuration, Copy data CTPIETE system cannauraton e =
. . Create status file:

» Update measurement configuration, Copy data

incl. PostMortem NoValue alarm timeout [s]: 2
MNoValue start delay [s]: 0

» Update measurement configuration, Move data

» Update measurement configuration, Move data,
incl. PostMortem

» Start logger in FTP mode
» Set the logger's system time
Administrator (directory ,,admin®)
» Update measurement application
» Update measurement application, Delete data
» Update measurement application, Update measurement configuration, move data
» FPGA update

Parameter of the “dataTransfer” service

<meaNumber>

If this parameter has not been defined, all data will be transferred. Valid values of this parameter are "all"
(not case sensitive) and a number between 0 and 9999. This parameter can be used multiple times. The
applied sequence has no effect on data transmission. The data transfer starts with the measurement data file
named with the lowest number in ascending order.

The file TESTdriveCmd.xml will be deleted from the server as soon as it has been transferred successfully. It
will be deleted from the local source if all <meaNumber> entries have been processed. The file name prefix
“TESTdriveCmd" is required, the file extension has to be“xml”. If the file name consists an 8 digit number
(e.g. TESTdriveCmd_12345678.xml) the logger will take this as serial number. The file will accepted only if
the serial number from the file name fits to the loggers serial number. If not, the file will be ignored and
remains on the FTP server.

The existing parameters <zip>, <crypt>, <split>, <move> and <useTimeDir> will be ignored. They will be
considered only if this service is applied by an USB stick. In this case, the TESTdriveCmd.xml remains
unchanged, as usual before and it will not be deleted.
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<transfer>

This parameter controlls the data transfer following to the data post processing (zipping, splitting, copying).
Valid values are "true" and "false". If the parameter is not configured, its value is set to "true" per default.

"true” Zipped and splitted (if required) files are copied to the USB stick.

"false" No measurement data is copied to the USB stick.
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4 External connection

4.1 Grounding

It is absolutely necessary to connect the logger case with a suitable ground pin within the
overall system. Without this grounding, EMV disturbances and uncontrolled voltage
interferences can restrict the measuring process.

4.1.1 IPElog, M-LOG grounding connection

IPElog and M-LOG provide a grounding tap by a blade terminal.
Use a 6.3 mm blade receptacle to connect the grounding tap.

4.1.2 FLEETIlog grounding connection

FLEETIog2 has four M4 threaded holes at each side which are
used to tighten the mounting brackets. We recommend to use an
appropriate ring tongue terminal with one of the side screws for
grounding the logger case. A fork tongue terminal can also be used.

4.2 PWR/Remote connection
4.2.1 PWR/REM cable 620-574

PWR+

PWR-

REM

Shield

switching the PWR+ line!
Never disconnect the PWR- (GND) line while the logger is running, because this will damage
electronic circuits. Switiching-on/off the logger via PWR- (GND) is absolutely not allowed!

/\ Always switch on and off the logger using the REM (ignition line 15) connector, never by
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4.2.2 Remote connection

| |
[
| 1 2
[
[
: Remote  —< [
[
[
| electron. control
| | ~ Il e . ECU of the
| vehicle
[
: Power IN + — :
: min.6 Vv (9 V) | all I al
| max. 55 V I T - o
[ : T PWR
| PowerIN- — | — . o
| ' i

The logger has internal buffer capacitors to avoid a data loss due to sudden voltage losses. The
regular shut-down is executed via remote and not by switching-off the excitation!

The activating via a remote impulse (impulse length > 20 ms) is also supported. But the
continuous remote signal must be received within 60 s, otherwise the logger is shut down by
= | the watchdog.

Example:

Start of measuring system with opening the vehicle door. The continuous remote signal is
received at motor start and the system continues measuring. If the continuous signal is not
received (no motor start), the logger shuts down after 60 s.
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4.3 Digital input/output connection

LOG-PWR switched logger excitation (not stabilized)
The excitation is supplied, as soon as, the logger is activated.

4.3.1 Connecting example digital input potential free contact with
external switch external switch + external switch + external excitation up to 42
(potential-free) external voltage external voltage 5 A
Up o 42 V' max. above 42 V V without any resistor or
LOG.PWR T . ovee voltage divider
C . —_—0
I = 5 MA : vce .
PN : . Terminal 15 of the board
| DIN-1 electrics (all vehicle power
L:|,;gz 1l g%iﬁ% Additional supplies up to 42 V without
C ™ bridge from DIN- any resistor or voltage
| ¢ GNDto PWR- o . o divider)
DIN-GND  GND at PROO, GND GND
PRO1!

PIN of the Sub D socket! This PIN has a direct connection to PWR-IN GND with the PRO3,

ii The digital inputs are electrically isolated but the respective DIN-GNDs are all connected to one
PRO4, PRO5, PRO6 port replicators!

The inputs are protected by an internal 5 mA current limitation.

Required minimum values at the input for a clean functionality:
Umin = 3 V bZW Imin = 2 mA

4.3.2 Connecting example digital output

external LED, or external LED or
external relay external relay +
(potential-free) external voltage

up to 42 V max.

LOG-PWR
,
Y

e L2 A N \ vee

S —T1 o
DOUT-1
z~A|:J g §B8H¥Z%§ GND (ground) switched

] PouT Ri=20Q
— N o

Il

DOUT-COM | GND
e
"
DIN-GND

external LED, or external LED or
external relay external relay +
(potential-free) external voltage

up to 42 V max.

DIN-GND L\
e Ll
~ ™~

I = 30 MA

= um W V+ (excitation) switched
|J El gDOUT-Z; R| = 20 Q

DOUT-3
DOUT-4

i<
i

——(
DOUT- COM | vCC
e
AY
LOG-PWR

The digital outputs are electrically isolated and can operate bipolarly but the respective COM
ports are all connected to one PIN of the Sub D socket!
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4.3.3 Connecting example external status LED

external LED
(potential-free)

LOG-PWR

LED-1 > green
(LED-2 > yellow)
sz::L’1

(LED-3 > red)
I = 30 MA
e

— r
— AS

SMD 0.1 A

e
Y
DIN-GND

&7 []

) CAN input Vehicle
4.4 Bus inputs A
CAN+
) ? CANH
R120 73
. Term._ |
4.4.1 Connecting example CAN bus CAN- _, Y CANL
CAN GND
D GND
4.4.2 Connecting example LIN bus L helichassis

Due to the galvanic isolation, the transceiver of the LIN measurement input must be power supplied by an
external source. This can be:

1. Connection of the vehicle’s bus power supply (Vesupply) or
2. Connection of the logger’s power supply (bridge from PIN 5 to PIN 1)
3. IPElog 2: a bridge between pin 3 (CAN ground) and 6 (LIN ground) is required

Variant 1: Connect Vg of the external LIN bus

G UB Supply
o LIMN
GND Actor

. SUBD 9Pol CAN3/LINT
fand
PIN 31 - SubD 9Pol CAN4/LINZ

|

|
[
I|
J|

@\
o W=

1 1."."
TERRY
(R

\ veooal |
cooon
CE-E-N-N

G UB SUDD|'\-‘ .::E;':I::!:-__-‘:'ncrc.*.h:
o LIMN
11D - Acior Variant 2: Supply via logger

l (bridge from PIN 5 to PIN 1)
L EI-HII-:-)";J--dnl ..................... 5
e L o - SUBD 9Pol CAN3/LINT
S=FW 2 : and
i-cphemraoncams PIN1 PIN5 © SubD 9Pol CAN4/LINZ

S=UB-OUT-
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5 Configuration with IPEmotion (extract)

The IPEmotion software is required for configuring a logger measuring system and the corresponding
IPETRONIK devices. The software must be installed on the notebook/PC, which is used to configure. (See
the instructions in Commissioning). IPEmotion also supports the online data measurement with using the
XCP service. You can find a detailed description of IPEmotion in the manual, which can be opened in the

software as a PDF.

5.1 First steps
5.1.1 Main dialog

After the start of IPEmotion, the following screen appears.

Main Navigation Tabs

N\

Quick Access Bar

~

[E=RSES)

-
ANEEAESANRLEARXXANGOOR - PPEmotion
File: Project | Signals = Acquisiton  View  Datamanager  Analysis  Reporting Sciptng  Info & e‘
= -2 . XCH=
= & ¥ i & >
System Comporents  Import Export Chedt  Adjust Detect Initialize Display Details
Configuration Access View
V03.51.00.30750 RC Mame Active | Unit Phys Min | Phys Max | Sensor Min | Sensor Max | Sampling ratsé
Name p I
DIN 01 0 1 0 1 1Hz
P DIN 02 0 1 o 1 1Hz
B Projectsettings 0 DIN 03 0 1 0 1 1Hz
nf  CANOL 0 DIN 04 = 0 i 0 1 1Hz
i CAND2 g DOUT 01 = 0 i 0 1 1 Hz -
inl  CANO3 o [l T | b
@ CAND4 o=
- DN P General | Format || Scaling || Display ” Calculation ” Freguency output || Limit value |
= Dour 4 Active: [@]
USB 0
g Name: |DOUT 04 |
ETH 0
COM-1 0 Description: | Digital output |
COD2 4 Reference: |DOUT 04/30002753 |
= Audio o—
& Display 0 Sampling rate: | 1Hz -
F @ Logger processing 11 _ _ o N
@ Status 1 Main window at selected tab “Signals
% Storage groups o
Messages x
Symbaol Time “ | Type Source Message =
H
% Messages | E= Status | E= Storing | [# Output |
W =
L o
IPEmotion automatically detects all available hardware connections at starting.
i If you want to reduce the required time, select Options > Pluglins for deactivating those
= interfaces, which are not used.
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5.1.2 The Title Bar

The title bar contains the quick access bar, the software name, as well as, a tool bar with the following

functions:
IPEmotion I. =N ﬂl
°|
E Help — Open the documentation IPEmotion.pdf where you can find useful information for a safe
and clean application of the software.
= Minimize — Minimize the application window of IPEmotion and place it in the task bar of your
desktop.
El Maximize — Make the application window visible on your desktop and refit the prior size.
[ x| Close — Close the application of IPEmotion.
5.1.3 The file menu e NEEE
The file or application menu contains basic functions as: New, Open, Save, Save As,
Runtime version, Print and Close, as well as, further properties such as View, D New
Options, Support file and About.
The right partial view of the application menu contains a list of the recently used - Open
projects.
E Sawve
The View function contains the menu points Message window and the Reset
command. Show or hide the message window and reset the displaying configuration to E Save as
the default parameters.
EE:' App-Export 3
5.1.4 Using the options @ S—
With the Options entry, you have the ability to edit user defined settings. You can _IZI
define the following options: =i P 8
» Frequently used EE‘ view ,
» Basic settings -
. View I;l Administration  »
» Data manager e Options
» Analysis ‘_|
f About
» Units ‘o
» Plugins Close
The following section offers you a detailed overview over the available setting options.
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Frequently used

Activate or deactivate Start with the latest configuration and define the settings for the automatic
hardware detection. Activate or deactivate the automatic hardware detection at start of IPEmotion and
select a possible standard command after successful detection:

#= IPEmotion options E
Frequently used Start with the latest configuration: []
Basic sett
a Indude external files in configuration: []
Appearance
] Include options in configuration:
View
Diata manager Automatic hardware detection at start: [
Import Standard command after successful detection:
Export
Analysis
Maps
Basic settings
Select a preferred configuration type: Hardware configuration or signals configuration
Activate or deactivate the options: Accurate acquisition chain required and Expert mode.
#= IPEmotion options E

Frequently used
Basic settings
Appearance
View

Data manager
Import

Expart

Analysis

Mans

Expert mode

Preferred configuration type: @ Hardware configuration

) Signals configuration

Signal database:

Accurate acquisition chain required:

= O

Expert mode:

Automatic service administration:

=

The protocol nodes of imported description files (CANdb, A2L, FIBEX,...) are visible, this

means, the user has access to the signal properties.

With the protocols CCP and XCP the DAQ lists are displayed and can be processed (delete,

move signals).

With the release of IPEmotion V01.07.00 internal channels (-> Variables) for temporary storage
tasks have been implemented. Managing this variables is only supported with an enabled

Expert mode.

Activate the Automatic service administration option to automatically import the active channels into the
DAQ lists of the XCP service. These channels are then available in online view.

Please note the restrictions depending on the Ethernet interface of the PC and the number of
active channels. In this case, it is recommended to manually import the required channels into
= | the DAQ lists of the XCP service (deactivated Automatic service administration)
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View

Define your view settings according the following listed points:

Language selection Skin selection Displaying tooltips

Font size of the visual elements Transparency of configuration dialogs (0 — 30 percent)

Activate or deactivate the use of the Windows standard dialogs for the file and directory selection.

#= IPEmotion options E
Frequently used Language selection: |English -
Basic settings

Skin selection: |Light blue -

Appearance
View Display tooltips:
Data manager Font size of the visual elements: M -
Impart Transparency of configuration dialogs: 0 I
E t

nrLt Use Windows standard dialogs: []
Analysis -
Mape Time channel format: ) Relative

@ Absolute

Directories

Data manager

Define the Time channel format as Relative or Absolute (This setting is currently not supported for the
export into external formats!) and activate or deactivate the option: Merge time channels with equal
acquisition rate.

== IPEmotion options E

Frequenthy used Merge time channels with equal acquisition rate:

Basic settings
g Merge data at loading:

Appearance

View Display absolute times in time zone: ) Local time of analysis system

i@ Local time of measurement system
Data manager

@ uTC
Impart )

Expart

Analysis

Select the points per diagram graph. Define if all signals are considered in the analysis diagrams at
drawing the graph or only the samples. Move the bar accordingly to the preferred speed or quality.

#= IPEmotion options E
Frequently used Data display in charts:
Basic settings Speed Quiality
Appearance
View Use extended measurement window:

Data manager —
Highlighting of cursor quidance curve: @ Bold line
Impart

) Flashing line
Export =

2 Mone
Analysis
Maps
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Units

Get an overview according the common physical values and their respective unit and edit them.

= IPEmotion options ﬁ
Frequently used Physical quantity Unit
Basic settings Length -
Appearance Mass kg
View Time E
Datamameg Electric current A i
A Temperature oC =
Molar amount mal
= Light intensity cd
Analysis Electric vaoltage v
Maps Electric resistance Q
Directories Frequency Hz
Uniits Force N ) -
. ] Activate this Plugln for all logger
Hotkey applications.
The corresponding TESTdrive
Pl ugins version must be available at the
logger!
Activate or deactivate the hardware systems to be used.
= IPEmotion options ﬁ

Frequently used Active Title Version scription Manufactu
Basic settings O i | PETRONIK CAN 01.14.01 Connection of IPETROMIK CAN acquisitio... | IPETRC *
Appearance || E IPETR.OMNIK X 02.02.00 IPETRONIK CAN and Ethernet devices IPETR(]
View i IPETRONIK LOG Q- - @
Data manager L1 =] CAN-Send 01.00.01 CAN-Send with IPETRONIK CAN server IPETR
Import 1 @ CAM-Acquisition 01.06.00 CAN-Acquisition with IPETRONIK CAN-Ser... | IPETR( A
Export | &l | IPEsensors 01.00.00 IPETRONIK sensors PETRG
Analysis ] 8 | video 01.01.00 Synchronic recording of video data for ca... | IPETR(
Maps 1 ﬁ WAGO PLC 01.00.00 WAGO Controller OSRAM
Directories | & | Protocols 01.05.00 Protocol acquisition with any CAM hardwa... | IPETRQ
Units | w2 |ETH 01.01.00 LIDP or TCP socket connection IPETRC
Hotkey ] "'E technikmedia Universal Mo... | 01.01,07.0000 | Universal Modbus PlugIn Technil
User administration | £ | OPTRIS 01.00.00.123 | OPTRIS PI acquisition plugin PMR H: ™
IPEcloud 1 i ’
Pluglns Download

Clicking the wrench symbol ﬁ' enters the dialog for Plugln specific settings provided by the tab Options
and Components.

Components

With the Settings button, you have the ability to define the components (module type and priority, e.g. for
the type selection of the Dry configuration) of the respective hardware system and to edit additional options
settings.

The selection of the hardware components for the configuration by using a signal library is based on the
Priority. This preselection with a priority assignation of the system components facilitates the device
selection and improves the system speed.

The High priority defines a preferred use of the corresponding hardware component at configuring with a
signal library. The hardware components, which are defined with the Not used priority, cannot be selected
for an acquisition.
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Options

== IPEmotion settings - IPETROMIE LOG

Cptions | Components

General

Activate TESTdrive access restriction:
Encading of the configuration files:
Encading password:

Encoding of the syskem files:
Complete system configuration files:
Create status file:

Mavalue alarm timeout [s]:

ravalue start delay [s]:

Time zane
Time zone:

Summer time auktomatic:

Detection mode

O ) Loager with serial nurmber
O (@ Selection by dialog
) all loggers

R g

Importing mode

) Mowe:
) Copy
i@ Inquire

Extended

O
|
O
I

| Open syskem setup

0000000

|(GMT+E|1 000 Afsterdam, Betlin, Bern, Fome, Stockholm, Vienna

O

O

| | Cancel |

Extended options

Pz Extended options

Video input
Maximum mernory space
Maximum memory space (external)
Maximum file length
Audio input
Maximum memory space
Maximum file length
Sensitivity
Audio output
Volume
Delete audio files:
Other

:| 1000 MB
:| 1000 MB
:| 1000 MB

:| a0 MB
;6 MB
:| 67

;|87
w

System check enabled:
Use serial number as export file name:
Show export dialog:

Handle limits synchronously:

Waiting time for audio and video trigger
Postprocessing delay

Start processing delay

Retry processing delay

o

:|1,.55
:|1ms
:|205
:|15min

ECU init imeout: | 10 5

Extended comments
Use project parameter names
Transfer TSTdrive.zip to USB

Power out for display

IPEmotion Plugin IPETRONIK-LOG
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:| Undefined -
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Pz Extended options - 0O %

Retry processing delay: | 15 min
ECU init timeout: | 10 s
Extended comments:

Use project parameter names:
Transfer TSTdrive.zip to USE: [+

Power out for display: | Undefined -
Activating this check box will execute
[EEE R ~ an automatic CAN ID assignment
Activate auto CAN ID after detection: N starting with the predefined ID for
Start CANID: | 10 connected and identified modules.
IPEconf2 conform CANdb export:
C5V import mode: | Default v

Channel comments:

XCP service .. .
. Data transmission rate settings
sloe= L N slow: 1..5Hz
Medium rate: | 10 Hz < medium: 10 ... 50 Hz
Fastrate: | 100 Hz - fast: 100 ... 1000 Hz

Send categories
Category 1: | Category 1
Category 2: | Category 2
Category 3: | Category 3
Category Off: | NoTransfer
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5.1.5 Creating a support file

With the Support file entry of the application menu, you
have the ability to create a support file and add and/or edit
own comments and error descriptions.

Enter in the appearing Create support file screen an error
description. Accept the default location for the file. To
select another location click on the 2/ symbol.

After you have specified the location and a user defined
file name, click Save to return to the Create support file
screen.

= Create support file E3

Description:

File::

oK Cancel

i@ ama L RBER Bk

S

(=

@

delEWihmEEFEI

After clicking on OK a zip file is generated that contains the error description, as well as, the following

information:

» System information (Windows version, computer name, free memory on the local drives, ...)

» Current configurations (acquisition, online view, script configurations)

» Trace files (NET, C++)

If you have any problems while working with IPEmotion, send us this support file at

support@ipemotion.com.

IPEmotion Plugin IPETRONIK-LOG

FaW Lt
- | Reset

Hew _I_J Default parameters of the

displaying s=ttings
Open Reset templates

Select and delete templates
Save

ﬂ Reset formula pool

Delete formulas from globa

Save as formulz pool
Support file
- Support file creation
Runtime version
Compare
Print 3
View »
Administration  »
Options
About
Close
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5.1.6 IPEmotion working areas (main navigation tabs)

The main navigation tabs allow a quick activation of the different main functions of IPEmotion. A tab
displayed in light blue indicates an active function.

IPEmotion is designed to follow the main navigation tabs from left to right. Use this reasonable order like a

read thread, which guides you step-by-step to a successful acquisition.

Project Signals | Acquisition | View Data Analysis | Reporting | Scripting | Info
manager

Project Define your general user defined project data.

Signals Configure the connected acquisition systems and modules.

Acquisition Configure the desired storage groups and channels.

View Take a measurement defined by the connected hardware modules and the set

configurations.

Data manager

Manage your stored acquired data in all the supported formats.

Analysis Visualize your channels with diagrams.
Reporting Create reports and project documentations.
Scripting Automate your acquisition sequences.
Info Get a basic overview and general support.
Project
atEEESES Y "a) LQOHE - IPEmaotion | S
File Project | Signals  Acquision  View  Data manager  Amalysis  Reporting  Scripting  Info (2 0
- E E & &5
ﬁ [Ty rm |
New Open Save Save as Generate  Guidance
File Configuration
Project properties
Mame Value
¥ | Company name
Serial number
Manufacturer ID
Project name
Project manager name
E-mail address project manager
User
E-mail address user
User login hu
Description
IPEmotion version V03.00.03
File name
Date 01.08.2013 16:37:18
W
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Signals

’»-ﬁ«ﬁﬂar: gvﬁamuaaxf<nmmee@@ © L0Gen-Pemotion =] B [
Project Signals Acquisitio Data manager Analysis Reporting Scripting I 9
7T == %
= 8 & 3 ﬁ Q l"I '1?" Chi=
System Functions Import Export Check Adjust Detect Initiglize Display | Details
V03.59.00 Mame Active | Unit Phys Min Phiys Max Sensor Min Sensor Max | Sampling rate
Mame z ¥ L} -
DIN 01 W
4 B 82501109 DIN 02 v ] 1 0 1 1Hz
E Project setlings 0 DIMN 03 a 1 1Hz
T canot 0 DIN 04 0 1 Channels 1Hz
z CAN 02 o DOUT 01 v 0 1 [ 1 1Hz
4 canos 0 DOUT 02 v o 1 0 1 1Hz
i CAN D4 S DOUT 03 1] 1 0 1 1Hz
i CAN O3 0 DOUT 04 a 1 ] 1 1Hz
T canos 0
-1.}- LIN 01 0 Internal temperature v =C 128 127 128 127
"1-}' LIN 02 0 Pawer supply v v 0,000 65,535 ] 65,535
ETHO1 V] Caps voltage W 0,000 65,535 a 65,535
ETH 02 0 Start reason o [} 0 [}
2 bom 2 Yellow LED 0 1 0 1
£= Dour System tree 2 Red LED 0 1 0 1
h U 0 Remate 0 1 0 1
+m El . X g Remote 01 v} 1 ] 1 -
fmm  ACP service 7
CoM-1 ] | !
COoM-2 0 General | Extended | System activated Datamanager  Log file categories
GIET g Front number: | 1109
Ch Display 0
f  Logger processing 3 TESTdrive version: Update
fif  Status 3 Appendix: Remove
=
:; ;:IFZ?DEU?:F:UDS E Rescue configuration:
g; Traffic groups V] Time zone:  From options
SE  Statistic group 0 Summer time automatic: j . .
SE  Novalue group 0 Configuration dialogs
fih Farmulas 0
W =

5.1.7 Info

The chapter offers a basic overview of the IPEmotion software. In addition, it shows useful advices and tips

and tricks on how to use IPEmotion.

The view Info is divided into the following menu points:

» Welcome

» Release Notes (only in English)

» Red thread

» Tips and tricks

» Keyboard handling

» Documentations

» Contact and support

IPEmotion Plugin IPE

TRONIK-LOG
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5.2 Logger settings

General
© ™
hﬁﬂg@ﬁgvﬁaau@gxo\nmmeo@ . IPEmotion =B s
Project Signals Acquisition View ag Analysis Reporting Scripting Info 9
LI - ( \ %
- i ﬁr{?z I'I*?" ®
System Functions Import Export Check Adjust Detect Initigize Display | Details
V03.558.01 MName Active | Unit PhysMin  PhysMax | Sensor Min |Sensor Max | Sampling rate
Name Z ¥ L] -
= » DINO1 v
B 82501109 7 DIN 02 v 1] 1 1] 1 1Hz
E Project settings o] DIN 03 o] 1 o] 1 1Hz
T canoi 0 DIN 04 0 1 0 1 1Hz
R CE = DOUT 01 v 0 1 0 1 1Hz
4 canos) Highlight the logger in DOUT 02 = o 1 o 1 1Hz
i CaMD4| the system overview to DOUT 03 0 : 0 : 1Hz
4 canos| fadein the configuration
- DOLT 04 0 1 0 1 1Hz
i caNos| tabs
—1.}- LIN 01 — Internal temperature v C -128 127 -128 127
T ooz Power supply v v 0,000 65,535 0 65,535
ETH 01 Caps voltage | W 0,000 65,535 o] 65,535
ETH 02 o] Start reason o] B 0 B
f2  om 2 Yellow LED 0 1 0 1
S8 pour 2 Red LED 0 1 0 1
® uss o Remote 0 1 0 1 =
4 ETH 0
4 1B XCP service 7 General | Extended  System activated  Data manager  Log file categories
%  paQlistslow 7 e [
% DaQ list medium 0
@ DAQ list fast 0 MName: 82501109
COM-1 1] Description: | Ultra-compact modular data logger with 6 CAN interfaces and 2 LIM interfaces and 2 ETH interfaces
g COM-2 0
) Reference:
Audio 0
Ch  Display 0
4 Logger processing 3
fif Status 3
S5 Storage groups 0~
W &
-~
Extended
General | Extended System activated Data manager Log file cateqories
Front number: | 1109
TESTdrive version: Update
Appendix: Remove
Rescue configuration:
Time zone: |From options
Summer time automatic:
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Front number: The last four digits of the logger serial number.

TESTdrive version: Version of the TESTdrive application running on the logger. With a hard-
ware detection through a LAN/WLAN connection, the current version is
indicated. A mouse click to Update will upload the latest version.

Appendix: Transfer a user specific file to the logger.
Rescue configuration: Store rescue configuration on the logger (fall back)
Time zone: Applying the Plugin settings defined under Options > Pluglns

> Plugln-specific settings > Time zone

Summer tine automatic: Automatic switch-over winter time <> summer time

System activated
GEnera Extended System activated | Data manager og file categories
Switch-on condition (WakeonCAN): Start-Stop Switch-off condition:

Timeaout:

| Open the dialog for WakeupOnCAN and NML configuration ]

Mew measuring file number:
Start with number:

Follow-up time: |10 s

Transfer unit switch-on condition: |Postprocessing v

Cydical data saving:

Switch-on condition (WakeonCAN): Selecting the CAN bus(es) to be used for boot up the logger by
the WakeonCAN feature.

Timeout: The logger waits this period for the remote signal resp. bus activity.

Switch-off condition: User defined condition (trigger, formula) to be used to switch-off
the logger. In case a remote signal (REM = ignition line 15) is still
high, the logger will shut down and power up again.

New measuring file number: Consecutively numbering of measurement data files beginning

with the predefined start number.
Start with number: Start number for the consecutive measurement file numbering
Follow-up time: When the switch-off signal has been identified, the logger waits this

period (and keeps on operating) before shut down.

Transfer unit switch-on condition:  Switch on the WiFi client respective the modem for wireless data
transfer by the logger.

Cyclical data saving: Acquired data is continuously stored to the measurement data file
(not only by stopping the measurement).
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Data manager

aYST

Xiended

m

L=

m
m
o

|pdate connection parameters:
Compress files:

Indude configuration file:
Indude log file:

Parallel data transfer:

Data interface:

Update connection parameters:

Compress files:

Include configuration file:
Include log file:

Parallel data transfer:

Data interface:

Log file categories

"o Xiended

m
m
o

MoTransfer;
Category 1: [ |6,
Category 2:

Category 3:

{xT)
I

d Data manager file ca

ries

m

(10}

m

L] =

Configuration

[ Configuration of connection parameters

* LAM
WiFi

Enables the access to connection parameters settings by use
of the Configuration button.

Activated the compressing of measurement data files

Includes the DAQ configuration (CFG_xxx.isf) in the measurement
data zip file xxx_MEA_xxx.zip.

Includes the DAQ log file (MEA_xxx.log) in the measurement
data zip file xxx_MEA_xxx.zip.

Enables data transfer simultaneous to a running data acquisition

Selection of the communication interface (LAN, WLAN)

Log file categories

Select the Data manager
tab and click Configuration

IP= Data transfer configuration: 82501109

Genera Medium selection  LAN ~ Modem | Categories
Medium Category 1 Category 2 Category 3
Modem | % 1

NoTransfer: Exclude selected data from transfer.

Category 1: Assign storage groups, log file, ... to the data transfer category #1
Category 2 Assign storage groups, log file, ... to the data transfer category #2.
Category 3: Assign storage groups, log file, ... to the data transfer category #3

Data groups can be linked with a single or multiple data transfer categories.

&

Although a single or multiple data transfer categories can be assigned to a data transfer
medium (LAN, modem), a specific category can be assigned to a single medium only.
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6 Basic functions

6.1 Switching-on / switching-off

Description of the supported switching-on / switchting-off modes

6.1.1 Ignition line 15

Remote 1 (Ignition line 15) o
n
z 5 e g
[Oe)] oo ESaw
= = T
5§ 56 20D
53 53 3}
r e xr e =%o

Status - Booting

Measurement running

Zip, split, encode files

transfer data

(depends on settings)

Follow-up time - Post processing

SW Emergency switch-off
(Communication Timeout)

HW Emergency switch-off***
(Power Management)

I
I
I
I
I
I
I
I
I
I
I
I
I
T
I
I
i
. I
Follow-up time :
I
]

Variant t 1

--A-—-4-----4------}-------—-- Ready for operation

Continuous Remote** ! .
—1>20 ms—

Variant 2*
ON pulse+ == —  —t—--==--

”

| 1 1
i i i
| 1 1
1 | 1
[ : i
1 [ P—
I I 1
e ' 2h —
| 1 1 -t
1 ] L
| I ]
1 1 1
1 1
—| |
1
i i
1
!
q—>1s —pi i
1
1

Continuous Remote**

Timeout

*Variant 2: Switch-on condition (WakeOnCAN) enabled, continuous remote signal required before timeout expires

**Conitnuous Remote: If a remote signal (duration > 1 s) is identified during post-processing, the logger will stop this task and start a new acquisition.
***HW Emergency switch-off: The logger will be absolutely switched-off by the power management 2 h after the previous falling edge

of the remote signal.
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6.1.2 WakeOnCAN

[7)] —_
o - v @
WakeOnCAN, Ignition line 15 2 = 2
5 s 3 cmg
T ] E QO ©
) (@) )
g = : el
= o = o 258
o x e = NsZ
2 3 1 L 3
Status -Bootmg Measurement running | Follow-up time - Post processing -
1
|
1

SW Emergency switch-off
(Communication Timeout)

e d e ———————~  Ready for operation

]

I 1
I 1
I 1
I 1
i i
1 1
I 1
i < 2h i >
I --
HW Emergency switch-off*** ' H I
(Power Management) ! ! ! o
i — |
Follow-up time ! ! | :
: ; i :
T 1
WakeOnCAN* — i |
1 21 T i
1 1
] |

Continuous Remote** _____

Timeout

*WakeOnCAN Ign. 15: Switch-on condition (WakeOnCAN) enabled, continuous remote signal required before timeout expires
jumper Pin 3-6 and Pin 8-9 at respective CAN input to indicate bus traffic (WakeOnCAN)!

**Conitnuous Remote: If a remote signal (duration > 1 s) is identified during post-processing, the logger will stop this task and start a new acquisition.
**HW Emergency switch-off: The logger will be absolutely switched-off by the power management 2 h after the previous falling edge

o -
- » %)
WakeOnCAN without 5 o = 2
Ignition line 15 T 0 =
@© = @
[ o
5 & 5 g . S25
T ! ©
2 8 2o 8 =28
5 5 530 325
£ 8 2523 2o
z Q 2000 2cd
o 12 nh=0o NsZ
Status - Booting Measurement running Post processing -

SW Emergency switch-off
(Communication Timeout)

1
HW Emergency switch-off imactive
I

HW Emergency switch-off***
(Power Management)

Follow-up time inactive

Follow-up time

WakeOnCAN* —j

Switch-off condition true

1

*WakeOnCAN without Ign. 15: Switch-on condition (WakeOnCAN) enabled,, Switch-off condition configured,,
HW Emergency switch-off and Follow-up time out of operation, Timeout inactive
Jumper Pin 3-6 and Pin 8-9 at respective CAN input to indicate bus traffic (WakeOnCAN)!

Switch-off condition ~  --------------------——m—m o oo
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6.1.3 WakeOnRTC (IPElog/IPElog2 only)
With TESTdrive 3.52 and higher versions, IPElog supports switching on by its internal real time clock (RTC).

Supported events:
» Once start only one single time.
» Cyclic absolute cyclic start e.g. every hour (duration --> 1h), date/time stamp defines initial start up.

» Duration start e.g. every hour without predefined start-up.

( ‘ 1t WakeOnCAN, WakeOnRTC or WakeOnSMS is configured with IPElog, the Ethernet status
‘ LEDs (LINK, ETH1, ETH2) will light green, even if the logger is in standby mode.

afNEEESS Y ANLOORE - == /E
File: Project | Signals | Acquisition  View  Data manager  Analysis  Reporting  Scripting Info b 9
s =1 J_L ﬁ 'H'J" % |";"| %

& 1] "
Swstem  Components  Import Export Check  Adjust Detect  Initialize  Display Dekails
Configuration ACcess Wi
¥03.53.00 Mame Active | Unit Phys Min | Phys Max | Sensor Min | Sensor Max | Sampling rate
Marne b = =
¥ | DIN 01 (| o 1 0 1 1 Hz
4 = OIM 02 O i 1 ] 1 1Hz
E Project settings 0 DiIr 0= O ] 1 0 1 1Hz
qr Gl T DIN 04 O 0 1 0 | 1Hz
aF GG o DOUT 01 O o 1 0 1 1Hz
..’E!. AR L = DaUT 02 O o 1 i 1 1 Hz
&= AN ! Dol 03 | i} 1 il 1 1 Hz
5 CANOS o -
T canos 5 el 1T N4 | n 1 n 1 1 H?
"_:‘_' AN 07 0 General | Extended | System activated | Data manager
E CAMN 05 0 Switch-on condition (WakeonCAn): Ste IPS StartfStop configuration = || = ﬁ
T CANDY o ] :
T cantn 0 Timeout: 1m0 | - nector WakeOnCAN ML
—'fr- CAM 11 a Mew measuring file number: [] Cal 01 ] ]
i Eae L Start with nurber: |0 CAN 02 O O
cIhiEt z Follow-up time: |10 s AN O3 O O
4 ETHOZ2 0 pr time: CAN 04 O O
om DN 0 Cyclical data saving: [] CAN 05 O O
=2 pour 0
CAN 06 | |
Q Hsg b Cal 07 O O
CAN 05 | |
Cal 09 O O
: CAaN 10 O O
Cycllc_ p 0 0
Duration
~_ CAN 12 O O
1. Highlight the logger serial number at the
left system structure.
2. Select Start-Stop from the tab System WakeOnRTC
activated. P
3. Activate WakeOnRTC from the Start/Stop
configuration Mode: |Duration -
4. Select a start function from the drop down DiateTime: |02.06,2014 2042145
field Mode )
5. Define a Start time and/or Duration Duration: [1,00:00:00
depending on the selected mode. Measure:
6. Enable the check box Acquisition to
automatically start a data acgiusition with
the start-up procedure. 25 Cancel
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6.1.4 StopStart event (Logger processing)

The StopStart function closes the measurement file and after that immediately starts a new measurement.
This function is triggered by a user-defined event and starts without switching off the logger.

ADEEESBEYRELAGE XX

File

Project Signals | Acquisition  Yiew  Data manager
N el ﬁ | E" et 2 | Ewent
=+ + o — é
Systemn  |(Components| Import Export Check  Adjust & Ange into D
i z . - i B Extras 2 IE—I Multiple selection. ..
: Statiskic Tmport b
W03.53.00
Name '”; External programs Z -~ Expart L
&, Use as default
_— Ewvent handling L
i f N 0 Voot Chrl+s
§ a
'1'}- E Multiple selection, ., i] EE Copy Chrl4+C
T 8 Paste  Chrly
= o 0 2
52 pour 0 L Paste behind
W us L }"' Delete f
ETH 0 . 1. Select Event handling from the left-hand
& oM a B Clean menu.
& come o= B copyt 2. Select Components > Event from the tab
Audio 0 Ly menu or by right-clicking.
O} Display 0 [5 Past=frd 3. Choose the new event.
[7  Logger pro 0 | 4. Inthe Event tab, choose StopStart.
- ﬂ Propertiq . : . .
i Status d 5. In Trigger tab, define a triggering
SE  Storags aroups 0 condition (e.g. the formula:
SE  Maigroups ] "DIN 01" AND "DIN 02").
=B Traffic groups i]
fa  Calculations a
ADEEBSEY BRL AEXXONGOOR - =E -]
File Project | Signals Acquisikion iew [Data manager Analysis Repaorting Scripking Info (2] e
= 4 Lt OB B8 [
1 B Y i
System  Components  Import Export Check Adjusk Detect  Initidlize  Display Dekails
Configuration Access i
03.53.00 Mame Active | Description Event Trigger
Marng 2 [~
T CAND3 i UserEvent_4
—1!.‘?- CAN 04 o UserEvent_5
o=y o UserEvent_&
2: UserEvent_7
o DOUT o UserEvent_8
E LSE U |serEvent_9
ETH u]
& oMl 0 s
& comM2 0
Audio 0 General | Ewvent | Trigger |
00 Display e Event: |St0p5tart - |
A gy Logger processing o
7= Status 0
=E  Storage groups 0
=& Mail groups 0
=2 Traffic aroups 0
g Calculations 0
4 % Eventhanding 0
& signal generation 0
[ [
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6.1.5 Use Cases
WakeOnCAN with ignition on/off
Application

Test run with continuous measurement via signal “Ignition on / ignition off“ (remote); The logger is being
started using bus traffic (WakeOnCAN) in order to acquire the entire starting process. After test run, CAN
activity is to be acquired using the condition ,Ignition off*.

Requirements
» Data logger supporting WakeOnCAN feature

» Recognition communication stop on vehicle buses:
> |PElog or MLOG with 4CANQS cards and FPGA as of 1.08.01, TESTdrive as of 3.52.00

Sequence
Logger turned off
!
Remote control Central locking
!
Vehicle buses wake up
!
Logger boots
!
TESTdrive is started

!

Ignition on
!

Drive begins
!
Test run

}

Drive ends
}

Ignition off
!

ECUs still communicate

!

Bus is idle
}

Follow-up time (if configured)
}
Data post-processing
(Zipping, copying,... if configured)

!

Data transfer (if configured)
!

Logger turns off
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WakeOnCAN (bus activity)
Application

Monitoring of vehicle component on CAN, i.e. measurement as soon as/as long as the component is active,
independent from ignition state.

Requirements
» Data logger supporting WakeOnCAN feature

» Recognition communication stop on vehicle buses:
> |PElog or MLOG with 4CANQS cards and FPGA as of 1.08.01, TESTdrive as of 3.52.00

» Alternatively for other logger types / firmware versions:
> Use of switch-off condition or WakeOnCAN timeout

Sequence
Logger turned off
!
Vehicle buses wake up
!
Logger boots
!
TESTdrive is started
!
Bus is idle
!
Follow-up time (if configured)
!

Data post-processing
(Zipping, copying,... if configured)

}
Data transfer (if configured)

!
Logger turns off
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WakeOnRTC
Application

Independent from ignition state and bus traffic, the logger should start at 04:00 am every night, acquire data
via connected analog modules for 2 minutes and switch back to idle state.

Requirements
» IPElog with TESTdrive as of 3.52.00

Sequence

Logger turned off

!
WakeOnRTC at 04:00 am

!
Logger boots

!

TESTdrive is started
!

Configured turn-off condition becomes TRUE

!

Data post-processing

(Zipping, copying,... if configured)

!

Data transfer (if configured)

!

Logger turns off
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6.2 Triggering

The logger acquisition program offers 4 trigger conditions for every storage group to control the data
acquisition. The trigger conditions can be deduced from acquired signals, as well as, from calculated
channels. All data is written into the memory (RAM). If a storage condition is met, the data is asynchronously
written from the cache into the open measuring file on the flash card.

6.2.1 Start-trigger

Start of data storage if trigger condition (impulse) is met. Stop of storage with (correct) logger shut-down
(Power down). A defined follow-up time extends the data acquisition for x seconds.

Module

Trigger

Measure

Store

Remote ON
(switch on)

Ready for measurement

wait for trigger

Trigger condition fulfilled
not fulfilled

Trigger condition

trigger active trigger inactive

Remote OFF
(switch off)

}data rec. dela_

F |

Acquire data and write continuously to the buffer memory

1 [}
| . Pre-Trigger Data _|
|

Measurement data stored to internal memory

6.2.2 Stop-trigger

Time

v

Begin of data storage with logger switch-on (Power up). Stop of data storage if trigger condition (impulse) is
met. A defined follow-up time extends the data acquisition for x seconds. If no trigger event is set, data is
recorded until “Remote OFF” or end of the follow-up time.

Module

Trigger

Measure

Store

Remote ON
(switch on)

Ready for measurement

boot

wait for trigger

Trigger condition fulfilled
not fulfilled

Trigger condition

trigger active trigger inactive

Remote OFF
(switch off)

data rec. delay-

Acquire data and write continuously to the buffer memory

I
‘g
%
| |

Post-Trigger Data,

Measurement data stored to internal memory

IPEmotion Plugin IPETRONIK-LOG

Time

v

We recommend to use the function VALID(x ; y) in order to avoid irregular NoValues which
may influence a correct triggering.

Example:

Start-trigger: VALID(,Channel01“> 15; 0)
Stop-trigger: VALID(,Channel01“> 15, 1)

IPETRONIK GmbH & Co. KG
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Storage as soon as Channel01 > 15
Storage as long as Channel01 > 15
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6.2.3 Start- and Stop-trigger

Begin of data storage if start-trigger condition (impulse) is met. Stop of data storage if stop-trigger condition
(impulse) is met.

A defined follow-up time extends the data acquisition for x seconds. If no stop-trigger event is set, data is
recorded until “Remote OFF” or end of the follow-up time.

€
(0]
=
Q
3 >
0 L
A = = E y = L =
O35 S o) 5 o0
L < h= i)l 2 c
g2 3 £ 2 g2
T = 3 © o c 2
xr o 2 N ] xr 2
Modute [BIBEI boot  wait for trigger wait for trigger data rec. delay|BEN
I I I I 1 1
| | ; | i i
I I I 1 1
e i 3 | 5
I I I 1 1
sop- | 1 1 | |
trigger ! i ! ! i !
Measure 1 Acquire data and write continuously to the buffer memory }
I 1
| | | Pre-Trigger Data _| i Post-Trigger Data| | |
Store 1 | Measurement data stored to internal memory |
| | ! |-
Time

6.2.4 Stop is inverted start
Data storage for the time of meeting trigger condition (status).

A defined follow-up time extends the data acquisition for x seconds. If trigger status does not change after
successful trigger condition, data is recorded until “Remote OFF” or end of the follow-up time.

- L]
c
@ 2
= =
(0] 3
A 5 c c
o ks S
0 % = L
Zo £ g g oS
2 S S o 3 = Py G
55 > o) o> 55
g L ] (o) 204 £ 2
o} % b 2 Qé 2 %
r L I = - r L
Module - boot i wait for trigger i trigger active i trigger inactive data rec. delay-
i H i i i H
1 1 1 1
Trigger " : I l " :
gag T 1 1 1 | 1
: 1 ] I’
Measure E Acquire data and write continuously to the buffer memory i
T —_— . ey fe====s 1l
i i i i i i
| H | . Pre-Trigger Data _| | Post-Trigger Data| ! H
R e e =1
E i ' o . P
1
Store i i Measurement data stored to internal memory ] i
. L ———— | >
Time

The Follow-up time may not be mistaken for the Post-processing time. Both settings must be
coordinated. The maximum post-processing time is set with Logger > Settings > Data transfer

= timeout. This setting limites the switch-on duration after successful “Remote OFF” signal. The
logger is regularly shut down after this time even if the data post-processing (zipping, splitting,
sending) is not yet completed. The post-processing value must be at least 5 min greater than
the currently set follow-up time!
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6.2.5 Save trigger channel

If Save trigger channel is activated, trigger status and some additional information are stored in an implicit
channel (Word data format) in every storage group.

Bit coded information in trigger status channel

Bit No. Description Description (if bit value = 1)
0 Pre-Trigger Pre-trigger time running
1 Between start and stop Trigger signal status

This bit is set during the whole acquisition in Continuous
acquisition mode.

2 Post-trigger Post-trigger time running

3 Trigger Event This bit is set for the time of one signal at every Low > High of the
trigger signal. It is set once at acquisition start in Continuous
acquisition mode.

4 Maneuver Maneuver recording running (No NoValues available anymore)

5 Res Currently not used!!

6 Res Currently not used!

7 Res Currently not used!

8 Res Currently not used!

9 Res Currently not used!

10 Res Currently not used!

11 Res Currently not used!

12 WakeOnCAN WakeOnCAN ist active

13 Power Bad The logger is disconnected from the power supply.

14 Power Good Buffer capacitors loaded

15 KL. 15 Debounced remote signall (terminal 15)
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6.3 Data groups (storage, e-mail, traffic, statistic, novalue)
TESTdrive 3,55 supports 5 different types of data groups:

» Storage groups time related data storage on the logger
» Mail groups send data snap shot at trigger event per e-mail
» Traffic groups event related (time stamp) data storage on the logger (trace data),

license required

» Statistic group STG file (Statistic Group) containing min, max, mean values of the
respective signals created at the end of each measurement

» NoValue group NoValue monitoring of defined signals

TESTdrive supports various data groups to merge signals (direct signals, as well as, calculated channels) for
further data processing. Storage groups can have an own storage rates — independent from the signal rate.
This storage rate can be valid for all signals in the group, i.e. the signal is detected with the set sampling rate
and recorded with the storage rate or the individual signal sample rate is used for storage.

The maximum storage rate of a group is defined by the signal with the highest sampling rate. The frequency
for online calculations corresponds to the highest sampling rate in the calculation.

Each data group has its own trigger condition (see 6.2 Triggering) which can be individually defined by the
user. This offers the possibility to process (storage, sending) selected signals dependent on specific events
occurring, which may reduces the amount stored data and provides an easier offline data analysis.

Overview
Data group Settings Trigger Category Remark
Storage storage rates, time stamp and different trigger Yes time related cyclic
groups trigger channel, NoValues, modes available, data acquisition
enable external storage medium , formula to define
storage group name = mea prefix trigger condition
Traffic enable external storage medium , different trigger Yes time stamp related
groups storage group name = mea prefix modes available, bus trace acquisition
formula to define
trigger condition
Mail recipients, subject line formula to define  No signal snap shot at
groups trigger condition trigger event as
status information
Statistic none none Yes min/max /average
group values at
measurement stop
Novalue none formula to define No log file reporting
group trigger condition

Categories (Data transfer category)

Data groups that create measurement data files can be assigned to data transfer categories 1, 2, 3 or they
can be excluded from data transfer. Each category can be linked with a single data transfer medium,
whereas all three categories can be assigned to the same data transfer medium.

Refer to 7.10 Data transfer & communication
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6.3.1 Storage groups

p
= 1y O ., | A
aNEEESS Y L HO QO

File Project | Signals | Acquisiion  VWiew — Data manager — Analysis Reporting
- - ¢
nies E /" ﬁ (
+ + {J‘ " N
System |Components| Import Export  Checdk  Adjust Detect Initialize Di
wae  Storage group S
-
V03.52.00 % Name Activel
Name W= Ring buffer group 7
Storage group 01 |
"_:‘r' IE—I Multiple selection... 0 Storage group 02
§ AT 0 Ring storage group 03
o]
= DN 2
=2 pout 2
@ UsB o
ETH a
COM-1 0 1
COoM-2 0
Audio 0
[0  Display o=
F Logger processing 0
oo Status 0
4 =E
&  Storage group 01 4
&=  Storage group 02 2
= Ring storage group 03 2
R =E  Mai groups 0
v g8 Trafficaroups 0 -
[ PR DR Jupu— Fat

1. Select Signals navigation tab.

2. Select Storage groups.

3. Select Add component > Storage
group from the tab menu or the context
menu (right mouse button).

4,

General tab.

Enter a name and a description in the

5. Activate the storage group

6. Select Add component > Channels
from the tab menu or the context menu
(right mouse button).

7. Select the signals and confirm with OK.

8. Define additional parameters with
Settings und Triggering.

STOTagE Qroup OIT UTE Oatd 10g0eT

Define the ring buffer group whose data...

bl

Storage group

General | Settings
Storage rate:

Time stamp channel:
MoValues:

Save trigger channel:
Prefix:

External storage:

Storage rate

Time stamp channel

NoValue

Triggering

From channel

Ring buffer group

General = Settings

Storage rate:

Time stamp channel:
MNoValues:

Save trigger channel:

Prefix:

Ring buffer

Ring buffer size:

Triggering

From channel -

ls

Selection of a fixed storage rate or a channel related storage rate (From channel).
Using the setting From channel means, .the channel with the highest sample rate
within the storage group will determine the storage rate.

The measuring data contain the absolute time channel (logger time).

The NoValue between the trigger events, which is defined in the respective chan-
nel, is added with Format.
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Save trigger channel

The trigger status channel is added to the storage group and recorded. This

channel contains additional information, which is saved with the single bits in the

data set.
Prefix

External storage

The storage group name ist used for the measurement data file name.

Data storage on external USB storage medium.

Refer to 6.5 USB medium for external storage for detailed information.

Ring buffer size

reached, the memory is overwritten beginning with the oldest data.

Defines the size of the ring buffer for measuring. If the max ring buffer size is

Use the ring buffer group to record data that are only needed in case an unknown event
happens, e.g. in the event of a fault. The ring buffer group contains all selected signals of a

defined period before end of measurement.

Choosing ring buffer size, consider the number of channels and defined data rates

6.3.2 Mail groups

p
aDEEESE Y B N[5 NGO - IPEmotion = | B |
File: Project | Signals | Acquisiton  View  Datamanager  Analysis  Reporting  Soiptng  Info [ 0
e =l == N
2 e/ M e H
System |Components| Functions  Imp Ewport  Check  Adjust Detect Initizlize Display Details
E il Access View
V03.54.00 I,\\g Mame PhysMin | Phys Max | Sensor Min | Sensor Max | Sampling rate
Name IE—I Multiple selection. .. Z b - .
1. Select Signals navigation tab.
2. Select Mail groups.
4 1§ 80002357 0 3. Select Add component > Mail group
[=]  Project settings 0 from the tab menu or the context menu
47 canoy 0 (right mouse button).
4 [[E IPETRONIK-CAN 0 4. Enter a name and a description in the
g 57801407 0 General tab.
fmg 58700743 0 5. Activate the mail group
& 58601209 0 6. Select Add component > Channels
T canoz o from the tab menu or the context menu
T canos 0 (right mouse button).
T cano4 0 7. Select the signals and confirm with OK.
“® g 0 8. Define one or more recipients using
(=1 . - .
£=  pour 0 Settings and define the start condition
# us 0q under Trigger. N
ETH 0
COM-1 o General
COM-2 0 Active:
Audio 0 -
Dl Display 0 Mame: |Mail groups
F Logger processing 0 Description: | Mail groups on the data logger
:i Stats ’ Reference: |Mail groups/80002367
== Storage groups 0
= ==
=& Traffic aroups 0
SE  Statistic group 0
iy Formulas 0
W =
\ y,
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r R
ATCEEBAa VYR ABXXOAGOOE - IPEmotion ESREERC
File: Project | Signals | Acquisiion  View Datamanager  Analysis Reporting Sciptng  Info & 9
= E = - b N
e 3 _ {y ! ;Eg CHl=
o+ =3 E @ v (3 | AN
System Components Functions  Import Ewport  Chedt  Adjust Detect Initialize Display Details
Configuration Access View
V03.54.00 Channel Index Active Unit sampling rate
Name Z 7
= 57801407 3 1 oC 2Hz
T cano4 0 57801407 _4 7 C 2 Hz
S8 DM 0 CPU load 3 o, 1Hz
am
cm DOUT a 57301407 _1 4 =] “C 2Hz
@ uss 0 i | sae01209_1 5 = Hz 500 Hz
ETH a
¥ | 53801209 2 = Hz 500 Hz
COM-1 0
COoM-2 0 /
Audio 0 General | Settings | Trigger
Display D/
Dl ) Active: [
4 gy Logger processing
fif  Status 1z Name: |Mail group 02 |
B  Storage groups ]
=E ge group Description: |Mail group on the data logger |
4 =2 Mail groups 0
= Mail group 01 1 Reference: | Mail group 02/80002367 |
=
=&  Traffic aroups
=E  Statistic group
fid  Formulas 00—

General | Settings Trigger|

Subject: |Exceeding temperature limit!

General || Settings | Trigger

Formula: | "57801407_3" = 90

/ i\a‘ Enter the logger settings Data manager > Configuration > E-mail to set the e-mail recipient
y and the mail server.

Creating mail groups is independent from a status e-mail.

The e-mail from the mail group configuration is send, as soon as the trigger event occurs. In
case of activated e-mail delivery using the data transfer configuration, a status e-mail is send at
the end of each measurement.

{F

IPEmotion Plugin IPETRONIK-LOG IPETRONIK GmbH & Co. KG ipetronik.com 66/ 173



Basic functions

IP=TRONIK

6.3.3 Statistic group

(= P BEE%a Y@

IPEmntionl =NREY é

v A5

AKXKONGOOE

Project Signals Acquisition B Data manage Analysis Reporting Scripting Info Q‘
(s g == N
: B B o Bl T ON=
System Components Functions Check Adjust Detect Initislize Display @ Details
V¥03.57.03 l Channel Index Active nit Sampling rate
a g []
MName + z
Companents ! ~
i 8 s * ™
% E Statistic group % i ’ <
¥ 0
F IE—I Multiple selection. .. 0
F — 0
2 DN 0
=2 pour 0
LUsE 0
ETH 0
COoM-1 0
CoM-2 0
Audio i} LEnEra Categories
Dl Display g MoTransfer:
fivl Logger processing 1
-’-“f Status i Categaory 1:
=E  Storage groups Category 2:
=E  Mailgroups
=E  Traffic aroups 0 Category 3:
=E  Statistic group
tish ] 0
=E  MoValue group
fig ~ Formulas o 1. Activate the Signals tab.
2. Highlight Statistic group.
3. Select Components > Statistic group from | |
- the tab menu or the context menu (right —
mouse button).
4. Enter a name and a description in the
Statisic groups contain min, max and mean General tab.
values of the respective signals stored in the STG file, 5. Activate the Statistic group.
which is created at the end of each measurement. 6. Select Add component > Channels from the
tab menu or the context menu (right mouse
Please also refer to button).
11.5.1 Data types > Min-Max list (STG file) 7. Select the signals and confirm with OK.
8. Definie a data transfer categorie to be used

under Categories.

You can now add your statistic information easily into a new created statistic group. You can create several
statistic groups which can be transferred through different means.

Using the “Components” button, you can open the channel selection window to select the channel you would

like to include in the Min-Max statistic calculation.
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6.3.4 NoValue group

' ™y
ATNCEEAS YR L ABXXOAAGOOEE - = Pimiton = E e
File Project | Signals Acguisition View Data manager Analysis Reporting Scripting Info & a
T B B 1y i & >
System Components Functions  Import  Ewport Check  Adjust Detect Initialize Display Details
Configuration Access View
V03.57.00 Channel Index Active | Unit Sampling rate
MName Z ¥
57800547_1 1 C 10 Hz
4 [ 30001820 5 2 °C 0 Hz
[  Project settings o 3 C 10 Hz
» T canot 4| | 57an1328_2 4 oC 10 Hz
§ CAnDZ 0 CPU load 5 % 1Hz
§  CAND3 0
T caNO4 o
= D 0
&= pour o
W usB 0
> ETH
COoM-1
coM-2 ]
G 0 General Trigger
LY Display o Active:
A gy Logger processing 1
.ﬁ;{ Ctatus 1 Mame: |N01.-'alue group 01 |
55 Storage groups 0 Description: |N0'u'alue group on the data logger |
B  Mail groups ]
HE SR Reference: |r-Jc-'-.'aIL|e group 0180001620 |
=2 Trafficgroups 0
SE  Statisticoroup ]
4 =5 NoValue group ]
> =
fih Formulas 0
L y

A NoValue group serves for monitoring invalid values occuring during data acquisition. Each NoValue event
(means that a sequence of valid signal values is interrupted by one or more invalid values) creates a log file
entry. You can use specific triggers to activate the NoValue group (for example: “CPU load” > 30 %).

Refer to 7.1.3 NoValue and timeout settings

6.3.5 Traffic groups

Time stamp related storage of CAN bus and/or LIN bus messages.

Refer to 8.2.3 Traffic acquisition

For explanations on cyclic and event-controlled data acquisition refer to 7.8 Event controlled measurement
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6.3.6 Trigger settings

General | Settings | Triggering

Mode: |Start- and Stop-trigger - ® —i
Pre-trigger duration: [10s (® 1
Post-trigger duration: |10 s —u—
Start-trigger: |"DIN 017 ()
Stop-trigger: |"DIN 027 Wi
Mode Select the trigger mode from Continuous acquisition (no trigger), Start-trigger,

Stop-trigger, Start- and Stop-trigger, Stop as inverted start (see Triggering)
Pre-trigger duration Data recorded before the trigger event

Post-trigger duration Data recorded after the trigger event

Start-trigger Value, which starts the data storage of the respective group.
Stop-trigger Value, which stops the data storage of the respective group.
Scaling Triggering the physical value or the raw value of the numerical value calculated

with the formula.

Define the triggering conditions as formula from the system signals and calculated signals. You
can optimize your data recording with a clever configuration of storage groups and triggering

= conditions to record signals at a high storage rate only if required. This method reduces the
data volume, saves memory, and facilitates the final analysis!

IPEmotion Plugin IPETRONIK-LOG IPETRONIK GmbH & Co. KG ipetronik.com 69/ 173



Basic fun

ctions

IP=TRONIK

6.4 Status channels

6.4.1 Logger, Logger processing

ADEEEREYRBELABAXANAMLOOR -

=El -

File Project | Signals | Acquisition  Wiew  Datamanager  Analysis  Reporting  Scripting  Info s o
= 6 30 E ABe B
28 = | |
Swstem  Components  Import Export Check  Adjust Detect  Initialize Display Details
Configuration Access Wiy
W03.53.00 Mame Ackive | Unit Phyys Min Phys Max Sensor Min
Mame Z 7
Remate 02 (] ] 1 ]
4 gB ‘Wake on CAN O 1] 1 1]
Project settings 0|y =
ERC il |uptime O |s 0,000 4294957,295 |0
g cano2 Bl | starage space O e 0 4294967295 |0
A CAM O3 1)
I Tirne left o |s ] 4794967295 |0
i CAMN 04 1] o
e Limik wiolation (] 0 1 0
= piy i
] DoUT 0 Measurement number ] o] 9999 o] e
o
4 m | r
® uss o
() ETH 0/ General | Farmat " Scaling " Display " Limit value |
8 comt 1 Active: [#]
& com2 i
) Audio 0 Tarme: |CPUIoad |
O} pisplay o Diescription: |DeFinethepercentaICPUIoadof TESTdrive. |
Ay Logger processing 1
W 1 Reference: | CPU load////a0002367 |
EE Skarage groups 0 Sampling rate: | 1Hz
=5 Mail groups i]
=8 Traffic groups i]
fl  Calculations a
s
e 5O o e O\ P o . = =
ETNEEERB VYRR ABAXONGOORE -
File Project | Signals | Acquisition  Wiew  Datamanager  Analysis  Reporting  Scripting Info
= L 0B A8 B
+ B E M
System Components  Impork  Export Check  Adjust Detect  Initialize  Display Deetails
Configuration Arcess Wi
¥03,53,00 Marne active | Unit | Phys Min | Phys Max Sensor Min | Sensor Max | Sampling rate
Marne
4 M E0002367 2|
Praject settings 0
T ocanot 0
FTocanoz 0
T ocanos 0
T AN o
= D i
= pour off
4 W uUsE 1
P Q Camera 1 General | Formak ” Scaling " Display " Lirnit: walue
£ Active: [#]
¢ e 0
& oMt 0 Mame: |Videofilesize |
= oMz 0 Description: |VideofilesizeoFUSBvideo |
) pudio 0 — .
Eh. Display a Reference: |V|deoFlle5|ze,f,f,fV|deorecordlng,l’SDDDZSs? |
] Logger processing 1 Sampling rate: | 1HZ|
P Status 1
=8 Storage groups 1]
=E  Mail groups Ofw
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6.5 USB medium for external storage
TESTdrive supports USB sticks and USB hard disks for storage on external drives in two different modes:
» External USB medium as alternative storage (solely saving on internal drive OR external drive).

» External USB medium as supplemental storage (depending on data type settings saving on internal
drive OR external drive).

6.5.1 External medium is the data drive of the logger

The USB medium is the data drive of the logger. Data is stored on this storage type exclusively. TESTdrive
creates the standard folder structure on the USB drive. Depending on the current settings, data post
processing and shutdown will be executed in different ways.

A Because of data loss, do not disconnect the USB medium during measurement!

Behaviour with FullPostprocessing
Since TESTdrive V03.23.00 this is the default setting when using an USB data drive.

Requirement

The non-bootable USB device has to be insert before starting the logger (refer to 6.5.2 External USB
medium as supplemental data drive for preparing the device). There should be no TESTdriveCmd.xml
available on the USB medium.

Utilization

During boot-up, the logger identifies the USB medium and reports “USB drive is data drive”. Measurement
data is stored to the subdirectory named with the logger’s serial number on this storage medium. The
FullPostprocessing procedure starts with the RemoteOff condition.

Behaviour without FullPostprocessing
This is the former procedure used for USB data storage until TESTdrive V03.22.01.

Requirement

The non-bootable USB device has to be insert before starting the logger (refer to 6.5.2 External USB
medium as supplemental data drive for preparing the device). There should be no TESTdriveCmd.xml
available on the USB medium. With TESTdrive version V03.23.00 and subsequent releases the following
command line has to be added to the dev_ctrl.xml in order to acitvate the usage:

<fastUsbDatatDriveChange>1</fastUsbDatatDriveChange>

Utilization

During boot-up, the logger identifies the USB medium and reports “USB drive is data drive”. Measurement
data is stored to the subdirectory named with the logger’s serial number on this storage medium. The
RemoteOff condition starts the following jobs:

» Checkdisk
» Preparing the directory structure on the USB medium
» Deleting temporary files and directories

» Power down

‘  Independent from any data transfer settings, measurement and configuration data will not be
‘ transferred for data drives without postprocessing.
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6.5.2 External USB medium as supplemental data drive

The USB storage medium is used in addition to the internal data drive of the logger. Depending on the
current settings, data is stored either to the internal drive or to the external medium. TESTdrive will create
the directory structure in any case.

The following data types are supported on the external USB medium:
» as of TESTdrive V03.52 storage and traffic groups
» as of TESTdrive V03.58 storage, traffic groups and USB video records

Requirement
e The non-bootable USB storage medium has to be formatted correctly!

The Windows console software diskpart can be used to prepare a non-bootable USB drive for external
storage.

if Please take care that you select the correct drive of your PC when using diskpart!

Formatting an incorrect (internal) PC drive may cause serious problems or damage the
computer!

DiskPart commands and meaning

DISKPART> list disk — Listing available drives

DISKPART> select disk 8 — Selecting the respectiv drive (here disk 8)

DISKPART> clean — Cleaning the selected drive

DISKPART> create partition primary — Creating primary partition using the full drive size

DISKPART> format fs=exfat — Fast formatting with the exFAT format and USB stick name
label=ExtStorage quick ExtStorage (label is an optional parameter)

DISKPART> exit — Closing DiskPart

Sample screenshot showing list commands

Microsoft Windows [Uersion 6.1.76011]
Copyright {(c)> 2089 Microsoft Corporation. Alle Rechte vorhehalten.

F:\>diskpart

Microsoft DiskPart—-Uersion 6.1.7601
Copyright (C)> 1999-206B8 Microsoft Corporation.
Auf Computer: 1TA2-8277

DISKPART> list disk
Datentrager Status

Datentrager
Datentrager
Datentrager
Datentrager
Datentrager
Datentrager
Datentrager
Datentrager
Datentrager

Kein Medium
Kein Medium
Kein Medium
Kein Medium
Online

RN LALON-®
ooeeeeee®
--]--]--]--]--}--}--}--}--)
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DISKPART> select disk 8
Datentrager 8 ist jetzt der gewdahlte Datentrager.
DISKPART > list partition
Partition ###t Typ GrolBe Of fset
Partition 1 Primar 7636 MB 4832 KB
DISKPART> clean
Der Datentridger wurde bereinigt.
DISKPART> list partition

Auf diesem Datentrdger sind keine Partitionen, die angezeigt werden konnen.
anden .

DISKPART > create partition primary

Die angegebhene Partition wurde erfolgreich erstellt.

DISKPART> list partition

Partition HHH Typ
* Partition 1 Primar 7639 MB 1624 KB
DISKPART > format fs=exfat label=ExtStorage quick
188 Prozent hearbeitet
DiskPart hat das Uolume erfolgreich formatiert.
DISKPART > exit
Datentragerpartitionierung wird beendet...

F:N\>_

M-LOG V3, but not with M-LOG, as the BIOS of the logger types are different!
For usage with M-LOG, the MBR (Master Boot Record) of the USB medium has to be deleted.

6 Upon completion of this preparation, the USB medium is ready for use with IPElog and

M-LOG V3!

ir Once the MBR of the medium has been deleted, it can be no longer used with IPElog or
We recommend to prepare separate USB storage devices for the respective logger types.

Deleting the bootloader requires a determination of logical and physical drive!

(Open Drive 3 2
The tool Hex Workshop can be used for deleting the bootloader, Select| | Physical Disks "‘I Lo |
as it supports access to the physical part of the drive. =1 Physical Disk 0 (143,05 G8] = el
The tool is available for download from: e o —
elp |
http://www.hexworkshop.com/
Read Only
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The MBR (Master Boot Record) is the physical drive area. The bytes asigned to address range 0x000 to
0x01B7 (Bootloader) have to be deleted, this means set to O.

g @ Hex Workshop - [Fixed Disk 0x86 <sector 0x00 of Ox3BBFFF>] _— -
r@ File Edit Disk Options Tools Plug-ins Window Hel
B N . B v B 104 15 (&)
SEHSHB | B E] Ban s &5 | %E@ e
2 | B FY AR M & EH ]LegacyASCIl '1 K 49 > v

18z||ENSIA BIEQ

FA 00 CcG 00 55 Aa

The TESTdriveCmd.xml with the contents listed below has to be copied to the USB medium:

<TESTdriveCmd>
<Authentication>
<user>guest</user>
<password>ipe_guest</password>
</Authentication>
<OnConnect>
<JobList>
<Job>
<Name>startExternalStorage</Name>
</Job>
</JobList>
</OnConnect>
<OnDisconnect>
<JobList>
</JobList>
</OnDisconnect>
</TESTdriveCmd>

disconnecting the USB medium.

fj Using a TESTdriveCmd.xml with other commands will execute these jobs and waiting for
The storage to the external drive will not be started in this case.
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In addition to an appropriate TESTdriveCmd.xml, the correct settings for storage and/or traffic groups or USB
video recording are required — Activate External storage.

Enera Settings Triggering Cat

Storage rate: | From channel hd
Time stamp channel; [+
MoValues: |«
Save trigger channel:
Prefi:

Prefix preview:

External storage: |«

With USB video recordings, the total memory space available on the USB device can be limited by Plugin
specific settings.

(Options — Pluglns — IPETRONIK LOG Plugln-specific settings — Extended — Open system setup).

Pz Extended options - 0O x

Video input

Maxirmum memory space: | 1000 MB

i

Maximum memory space (external): | 1000 MB
Maximum file length: | 1000 MB

Application

Storage on external USB device is supported for triggered measurements as well as continuous
measurements (TESTdrive V03.54.00 or a newer release required).

The USB medium can be connected to the logger before boot up or when the measurement has been
already started (TESTdrive =2 V03.54.00). TESTdrive writes data directly to the external USB drive.

If the start trigger for data storage is active but no USB device available, the logger will report the respective
warning:

"No USB-Stick with TESTdriveCmd. Storage group [Name] cannot be stored externally."
"No USB-Stick with TESTdriveCmd. Traffic group [Name] cannot be stored externally."
"Video([Nummer]): No USB-Stick with TESTdriveCmd. Video files cannot be stored externally."

The external storage has to be stopped before unplugging the USB medium. We recommend to end the
complete measurement (not only USB storage) as the operating system could respond unforeseeable on
unplugging the USB medium. If this procedure is not possible, a stop trigger has to be configured to end the
data storage regularly.

if Unplugging the USB medium while external storage groups are active causes data loss!

Configure stop trigger conditions or end the measurement (power down) to unplug the USB
medium from the logger without data loss.
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7 Standard functions

7.1 Calculations

TESTdrive supports the online calculation of the signals acquired in the system. The desired calculation is
defined with the corresponding software dialog — manually or with the formula editor.

IPEmotion Version 1.03 and Plugin IPETRONIK-LOG = V03.20 offer a shared formula editor, i.e. the
following calculation functions are available in IPEmotion, as well as, in TESTdrive.

VAN

Calculations, which are based on each other, must be run in the same cycle rate to get a
correct result! If, e.g., the result of a calculation with low cycle rate is used in a calculation with
higher cycle rate, a time offset results, which can influence the result according to a signal
change (amplitude). In that case, the signal sampling rate of the first calculation must be raised.

“, “ 9

The formula editor requires the use of the semicolon “;” instead of the comma “,” as variable
separator.

If a value within a calculation is “NoValue®, the calculation result is “Novalue®, too.

7.1.1 Mathematic functions and operations

1 Basic operation
Operator Name Syntax Example Result
+ Addition “Temp01“ + “Temp02“ 15+10 25
- Subtraction “Temp01“ - “Temp02“ 15-10 5
* Multiplication “Temp01* * “Temp02° 15*10 150
/ Division “Temp01“/ “Temp02“ 15/10 15
MOD Modulo, Division rest “Temp01“ MOD “Temp02°* 15 MOD 10 5
ABS()  Absolute value of a number ABS(“Temp01%) ABS(-15) 15
SIGN()  Sign of a number SIGN(“Temp01%) SIGN(15) 1
SIGN(0) 0
SIGN(-15) -1
NEG() Negation of a number NEG(“Temp01%) NEG(15) -15
NEG(-15) 15
( Begin bracket term (“Temp01“ + “Temp02) *2 (15 + 10) * 2 50
) End bracket term (“Temp01“ - “Temp02“) *2  (15-10)*2 10
2 Power, Square root, Exponential and Logarithm functions
Function Name Syntax Example Result
n Power “Temp01“ A 2 1572 225
SQRT() @ Square root SQRT(“Temp01) SQRT(25) 5
EXP() | Exponential function of basis e EXP(“Temp01“) EXP(5) 148.41
LOG() Logarithm of basis 10 LOG(“Temp01%) LOG(5) 0,4771
LN() Logarithm of basis e LN(“Temp01%) LN(5) 1.0986
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3 Trigonometric functions, Hyperbola functions
Function Name Range of values in radiant
SIN() Sine +/-3.99 rad
COSs() Cosine +/-3.99 rad
TAN() Tangent +/-3.99 rad
ASIN() Arc sine +/-1.0 rad
ACOS() Arc cosine +/-1.0 rad
ATAN() Arc tangent +/-1.0 rad
SINH() Sine Hyperbolicus +/-1.99 rad
COSH() Cosine Hyperbolicus +/-1.99 rad
TANH() Tangent Hyperbolicus +/-1.99 rad
4 Comparative operations (comparison of variable values)
Function Name Syntax Example
= Equal “Temp01“ = “Temp02* 15=10
15=15
<> Unequal “Temp01“ <> “Temp02“ 15<>10
15<>15
< Less than “Temp01“ < “Temp02* 10<15
15< 15
> Greater than “Temp01“ > “Temp02* 15>10
15> 16
<= Less than or “Temp01“ <= “Temp02“ 10<=15
equal 15<=15
20<=15
>= Greater thanor  “Temp01“ >= “Temp02“ 15>=10
equal 15>=15
15>=20
IF(; ;) If function IF(“Temp01“ >= “Temp02; x; y) x=1,y=0
“Temp01“ =15
Query to a specific status. “Temp02“ =10
If Occurrence > action 1, otherwise action 2 “Temp01“ =10
Example: IF(“Thermo_channel3“ > 30; 1; 0) “Temp02“ = 15
If Temperature > 30, Result: 1 otherwise 0
Action 1 and 2 can also be calculations.
5 Logic operations (comparison of signal states)
Function Name Syntax Example
AND And “Temp01* > “Temp02“ AND “Temp01“>10 15>5
15> 10
10>5
OR Or “Temp01* > “Temp02“ OR “Temp01“ > 10 15>5
10>5
10> 10
XOR Exclusiv or “Temp01* > “Temp02“ XOR “Temp01“>10 15>5
10>5
15> 15
10> 10
NOT() Not NOT(“Temp01“ > “Temp02“) 15>5
(inverse state) 15> 15
5>15
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6 Boolean operations (bitwise comparison of signal states)
Function Name Description Example Result
ANDB  And bitwise | Bits which are set in operandl and in 27 ANB 12 8
operand2 will be set in the result 11011 ANDB 01100 01000
(bit = 1), all others will be not set (bit = 0)
ORB Or bitwise Bits which are set in operandl or in 26 ORB 8 26
operand2 will be set in the result 11010 ORB 01000 11010
(bit = 1), all others will be not set (bit = 0) 27 ORB 13 31
11011 ORB 01101 11111
XORB  Exclusive or | Bits which are set only in operandl or only 26 XORB 8 18
bitwise in operand2 will be set in the result 11010 XORB 01000 10010
(bit = 1), all others will be not set (bit = 0) 27 XORB 13 22
11011 XORB 01101 10110
NOTB  Not bitwise Bits which are set in operandl will be not  NOTB 27 4
set in the result (bit = 0), all others willbe | NOTB 11011 00100
set (bit = 1)
7 Statistic functions
Function Name Syntax , Description Example Result
MIN() Minimum MIN(“Temp01*) 4]112]3|25]|17 3
MAX() Maximum MAX(“Temp01%) 4]112]3|25]|17 25
MEAN()  Average Average from all valid values
MEAN( ;) Average from Average from n valid values
n values
MINOR( ;) Less value MINOR(“Temp01%; “Temp02) 4112 4
MAJOR( ;) Greater value MAJOR(“Temp01“; “Temp02) 4]12 12
FLOOR() Round integer FLOOR(“Temp01) 13,72 13
off
CEIL() Round integer CEIL(*Temp01%) 13,41 14
up
ROUND() Round integer ROUND(“Temp01%) 13,41 13
13,72 14
LIN(; ;;) Linearization @ LIN(*Temp01
X node-1;y node-1;
x node-n; y node-n)
Runs a linearization with the defined
nodes. Betweenn=2andn =16
nodes can be defined.
8 Other functions
Function Description
EDGE_POS() Detect positive edge
1 if current value is > 0 and the previous one <=0
EDGE_NEG() Detect negative edge

1 if current value is <= 0 and the previous one >0
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Function
DIFF()

INT()

INT_ADD()

INT_UP()
PREV()
(,Temp1“ +
(PREV (,,Temp1“))
+ (PREV
(PREV(,,Temp1“)))
)/3
SHL(;)
SHR(;)

TESTBIT(;)

TESTMASKS(;)

TIME( )

TIMER( ;)

VALID()
VALID(X; y)

ISNOVALUE(X; y)

RADIUS(y; 2)

ANGLE(y; z)

Description

Runs a differentiation of an operand acc.to:
(Opri(t) — Opl(t-1)) * DeltaT

Calculates the integral of an operand acc. to:
"((Op1(t) + Opl(t-1))/2) * DeltaT"

Calculates the integral of an operand acc. to:
"((Op1(t) + Opl(t-1))/2) * DeltaT" and adds the
result to the previous value

Calculates the upper integral of an operand acc.
to: "Opl(t) * DeltaT"

Outputs the previous value.

Floating average from the current value and both
previous values

Shift value bitwise to the left.
Shift value bitwise to the right.

Checks the value (0, 1) of the defined bit. If the
bit described by operand 2 is set, result = 1,
otherwise result =0

(Counting order starting right hand with 0)
Makes a comparison with a user definable
bitmask. If at least one bit is set in operand 1 and
also in operand 2, result = 1, otherwise result = 0
TIME(*“Temp01*)

A counter that adds the time intervalls of the
corresponding sample rate continuously and
outputs the sum as long as the operator's value
is>=0.5

In case the operator's value is < 0.5, the counter
is reseted and O is output.

If no new value is received from the channel
defined as Parameterl within the timeout
(Parameter2 in seconds), the output value is '1".
Check for validity

Example Result

PREV(“Temp01*) 4 |

121325 NV 123
1 SHL 2 4

001 SHL 2 100

12 SHR 1 6
1100 SHR 2 0110
TESTBIT(1101; 3) 1
TESTBIT(1101; 1) 0
TESTMASKS(27, 6) 1
TESTMASKS(27, 4) 0

1 if value is unequal to NoValue, 0 if value is NoValue

Avoid Novalues

x if value is unequal to NoValue, y if value is NoValue

Delay of a NoValue identification (x: signal value, y: optional time delay)

If y is not set resp. its value is 0, the result is true, as soon as x = NoValue

Is y # 0 the result is true, as soon as x = NoValue for a minimum duration of y seconds.

Is x # NoValue, the result is always false.

Radius calculation polar coordinates (r = V(y*2+ z2)

= SQRT( "phi_y" * "phi_y" + "phi_z" * "phi_z")
Angle calculation in polar cordinates

= IF( "phi_z" >= 0; ACOS("phi_y" / "Radius" ) * 180/PI; -1 * ACOS("phi_y" / "Radius" ) *

180/PI + 360)
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7.1.2 Constants

9 Constants
Constant Description
PI Pi > 1 = 3.141592654 ...

SYSTEMRATE TESTdrive internally works with a fix system rate. This rate depends on
the configuration (Channel with highest sampling rate) and can be used
for calculations. The system rate can be compared with the timer ticks of
a PC clock and is set in Hz.

The system rate relates to the working frequency of the PC/Notebook (=
Frequency of the High-Performance-Counter).

SYSTEMTIME Reciprocal value of the system rate (=1/SYSTEMRATE) and is set in
seconds.

Please note at using a system rate in the MHz range that the system time
can only be correctly displayed if sufficient decimals have been defined
and Automatic has been selected in Display > Formatting.

SAMPLERATE Channel sample rate in Hz

SAMPLETIME Channel acquisition intervall in 1/s

7.1.3 NoValue and timeout settings

In order to differ invalid and valid measurement values, the user can select —FullScale, Null or +Fullscale (for
analog inputs) to be identified as invalid value (NoValue). A signal value at the upper or lower limit range
could be invalid, as it can not occur really. Another used case are missing messages at the CAN bus. An
expired fimeout can be used to indicate invalid values.

Settings possibilities
Measurement input
General | Format | Scaling || Display | Thermo || Limit value

Data type

Type: |16-Bit integer signed - Task: |Mothing -

MoValue [ Defaultvalue

value: |RIE=E + | [] Deactivate MoValue and use Default Value
Channel type Mull R}
+FullScale
Input: o

The setting for the signal input (e.g. IPETRONIK CAN measurement module) or the CAN signal input defines
the invalid value (NoValue) within the measurement range (selection -FullScale, Null, +FullScale).

If this function is deactive, the measurement value is used (e.g. -60 °C with M-THERMO), NoValues are
suppressed in this case.

A NoValue alarm can be activated for every signal within the Format tab.

IPEmotion Plugin IPETRONIK-LOG IPETRONIK GmbH & Co. KG ipetronik.com 80/ 173



Standard functions

IP=TRONIK

IPEmotion Options
The IPEmotion Options Expert settings (select Basic

settings > Expert mode) provide a No value timeout for the
online data acqusition. If values are missing with a cyclic data
acquisition, subsequent samples will be output as NoValue if

the timeout range has expired. The setting range for the No
value timeoutis 0 ... 5 s.

This setting has no effect on the data acquisition by the logger.

Please use the Plugln Options for this.

Plugin Options

Entering the IPEmotion Options, the options tab of the
Plugin IPETRONIK LOG (select current Plugin >
Options > NoValue-Alarm Timeout (s)) provides the
logger acquisition timeout. . If values are missing with a
cyclic data acquisition, subsequent samples will be output
as NoValue if the timeout range has expired.

The setting range for the No value timeout is 0 ... 120 s.

Conditioned by different delays during initialization
(modules, logger) when measurement has been started,
NoValues can occur during this phase.

Use the setting NoValue start delay (s) in order to avoid
NoValues at measurement start.

The setting range for the No value start delay is O ... 600
S.

IPEmotion Plugin IPETRONIK-LOG

IPETRONIK GmbH & Co. KG

= Expert settings

General options

Additional warnings:

Configuration options

Variable configuration:

Extended tabs:

Data acquisition options

Mo value timeout:

Limit message duration:

Description files import options

View protocols:
Edit protocol channel scaling:
View diagnostic jobs:

Ignore verbal tables:

Max. poling lists:

Use characteristics:
Support 11939:

Logging import:

Maximum size of acquisition data files:

0K

== IPEmotion settings - IPETRONIK LOG

Options | Components

General

Activate TESTdrive access restriction:
Encoding of the configuration files:
Encoding password:

Encoding of the system files:
Complete system configuration files:
Create status file:

MoValue alarm timeout [s]:

MNoValue start delay [s]:

|
100 MB
Os
5s
O
O
O
1 -
for calibration -
O
Cancel
O
O
O
O
2
a
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CAN input

Each CAN input of the logger provides timeout settings with an adjustable delay time (select for example
CAN 02 > tab Extended > Timeout value 2 s). If the CAN input do not receive messages anymore and the
timeout period has expired, the logger starts writing NoValues to the data record.

(e NEEEMBYREL ABXXAAROOBE - - PEmation L= ]
File Project | Signals | Acqguisition Data manager  Analysis  Reporting  Scripting  Info & e
= = | - e )
= 2 241 1T 0 LI O =
System Compenents Functions Import Export Check  Adjust Detect Initialize Display Details
Configuration Arcess View
V03.57.00 Mame Active | Unit | Phys Min | Phys Max | Sensor Min | Sensor Max | Sampling rate
MName Z v
 |'s |c_57801328_1 °C 1370,00
PR 20001620 3 C_57801328_2 o 10 Hz
[  Project settings 0 C_57801328 3 °C 10 Hz
4T canoi 0 C_57801325_4 5 10 Hz
4 [ IPETRONIK-CAN 0 C_57801328_5 =C 10 Hz
g 57800547 £ C_57801386 | [ | 10 Hz
4 ﬁ} — = C_57801328_7 oG 10 Hz
4 oy CANdb_M-TH2_1328_2... 8 -
A/  DEVICE_57801328_0 4 C_57801328 8 - 10tz
#A4  DEVICE_S57801328_1 4
E CAN 03 0 General IW Extended
j}ﬂ EL0H g Use timeout:
= pm 0
&8 pour o Timeout value: |Zs
W uss 0
F | ETH 4]
4 ﬁ XCP service 8
% DaQlistslow 0
% DAQ list medium 8
% DAQlist fast 0
CoM-1 /]
\ EI & J

Log file entries

If the NoValue monitoring is activated and NoValues are occuring, the system will record the series of
NoValues itself (instead of the signal value) and the corresponding log file entry.

Example
NoValue monitoring at CAN 01 Timeout value 20 s

Log file entry: D CAN signal measurement timeout (no valid ID) on CAN 01 (t > 20000 ms)
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7.1.4 Calculation examples

Greater comparison ,,>“
Syntax >

Description  Compares the current value (of a channel or a calculation) with a user defined constant or
variable. The result is 1, as long as the comparison is true, otherwise the result is 0 (for a
false comparison).

Example ,Channel01“ > 2 Comparison with a constant

»,Channel01“ > Channel02“ Comparison with a variable

Constant

Signal

Results

4

—>
Time

Variable

Signal

Result l ,—l

4

Time

Less comparison ,,<“
Syntax <

Description  Compares the current value (of a channel or a calculation) with a user defined constant or
variable. The result is 1, as long as the comparison is true, otherwise the result is 0 (for a
false comparison).

Example ,Channel01“ < 2 Comparison with a constant

,Channel01“ < ,Channel02* Comparison with a variable

Constant

Signal

Result

Variable

Signal

Result —l : i

>
Time
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Counter (without reset)

Syntax

Description

Example

Tip

,counter01“ + x
VALID(“Counter01”’; 0) + x

Counts continuously with the current sample rate, i.e. the counter value is increased by x
with each sample. The rise of the counter slope depends on the currently configured
sampling rate and the counter step. A measurement stop resets the counter to 0.

,Counter01“ = ,Counter01“ + 1
,Counter01“ = ,Counter01“ + 10

Used with TESTdrive (logger application) this recursive formula will result in valid values as
the initial value for variables is set automatically. Used with IPEmotion (Acquisition >
Calculations > Formulas) the respective formula has to be completed with the Valid function:
,Counter01“ = VALID(,Counter01 0) + 1

The Valid function sets the initial counter value to a defined value (here 0) in case the current
value is invalid.

Accumulates 1 with each sample
Accumulates 10 with each sample

Counter with counting condition

Syntax

Description

Example

Tip

Counter

Constant
Signal

Trigger

IF(“Channel01” > x; ,,Counter01“ + y; ,,Counter01*)
IF(“Channel01” > x; VALID(“Counter01”; 0) + y; VALID(“Counter01”; 0))

Counts continuously with the current sample rate, as long as, the current value of
"Channel01" is greater than x. The counter value is increased by y with each sample, as long
as "Channel01" fulfills the condition. Otherwise the counter remains unchanged. As son as
the condition is fulfilled again, the counter continues with the previous value. The rise of the
counter slope depends on the currently configured sampling rate and the counter step.

A measurement stop resets the counter to 0.

,counter01“ = IF(“Channel01” > 5; "Counter01“ + 1; ,Counter01)
Accumulates 1 with each sample as long as "Channel071“is greater than 5.
Stop counting and holding the latest value, as soon as ,,Channel01“is less than 5.

Used with TESTdrive (logger application) this recursive formula will result in valid values as
the initial value for variables is set automatically. Used with IPEmotion (Acquisition >
Calculations > Formulas) the respective formula has to be completed with the Valid function.

»

IPEmotion Plugin IPETRONIK-LOG

T —>
Sampling time
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Counter with counting condition and reset

Syntax

Description

Example

Tip

Counter

Constant
Signal

Trigger

IF(“Channel01” > x; ,,Counter01“ + y; 0)
IF(“Channel01” > x; VALID(“Counter01”; 0) + y; 0)

Counts continuously with the current sample rate, as long as, the current value of
"Channel01" is greater than x. The counter value is increased by y with each sample, as long
as "Channel01" fulfills the condition. Otherwise the counter will be reset to 0. As son as the
condition is fulfilled again, the counter restarts with 0. The rise of the counter slope depends
on the currently configured sampling rate and the counter step.

A measurement stop resets the counter to 0.

,counter01“ = IF(“Channel01” > 5; ,Counter01* + 1; 0)
Accumulates 1 with each sample as long as "Channel01“ is greater than 5.
Stop counting and reset to 0, as soon as ,Channel01“is less than 5.

Used with TESTdrive (logger application) this recursive formula will result in valid values as
the initial value for variables is set automatically. Used with IPEmotion (Acquisition >
Calculations > Formulas) the respective formula has to be completed with the Valid function.

»

T —>
Sampling time

Validation check ,,VALID“

Syntax

Description

Example

Tip

IPEmotion Plugin IPETRONIK-LOG

VALID(x)
VALID(X;y)

VALID checks the current value (of a channel or a calculation) for validity, i.e. if the variable's
status is ,invalid“ (NoValue).

With the VALID(x) function the result is1, as long as x is valid and changes to 0, as soon as
the x has the status NoValue.

With the VALID(x;y) function the result is x as long as x is a valid value. As soon as x will be
an invalid value (NoValue) the result changes to y. In case y is a variable (instead of a
constant) the result of VALID(x,y) will be NoValue, as soon as x, as well as, y are an invalid
value.

VALID(,Channel01%)  1if ,,Channel01“=|= NoValue, 0 if ,Channel07“ = NoValue
VALID(,Channel01%4) ,Channel07if ,,Channel01“=|= NoValue, 4 if ,Channel071“ = NoValue

When using a measurement value within a recursive formula (x = x + y) we recommend to
use the VALID(x; y) function in order to avoid invalid values (NoValue). Even if the
measurement signal becomes valid values, the recursive formula will not be calculated
correctly, once a NoValue occurred.

We recommend to use the VALID(X; y) function for any signal which serves as a trigger for a
storage group. An invalid trigger signal could prevent the start of the data storage even if the
trigger signal will become temporarily valid.
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Mean value (averaging) ,,MEAN*

Syntax MEAN(x)
MEAN(x; n)

Description  MEAN(X) continuously calculates the moving average from all valid measurement values.
MEAN(X; n) berechnet continuously calculates the moving average from n previous
measurement values.

Example MEAN(,Channel01%) moving average from all values of a measurement
MEAN(,Channel01%; 10) moving average from 10 values at a time

Tip The diagram shows the differences of the MEAN functions with a rectangle signal
(clock 5 Hz)

Square red origin signal
Mean Square blue  moving average
Mean_5 Square green moving average from 10 values at a time
1 -
0,8
0,6
0,4
0,2
D |
0 2 3 4 5 & 7 [sl] g 10 11 1 13 14 15
— Square — Mean Square —— Mean_5 Square

Linearization ,,LIN“

Syntax LIN(Operand; x-Node01; y-Node01; x-Node02; y-Node02)

Description Runs a linearization with user defined nodes. Between n = 2 and n = 16 nodes can be
defined. The scaled values (Y-axis) are calculated from the original measurement values (X-
axis) using factor and offset of the partial linear slope between two nodes.

Example LIN(,Channel01%; 0;-0,5; 2;1; 4;2; 8;2,5)

Tip The linearization enables a non-linear scaling (multipart scaling) used for physical graphs
without having a mathematical equation.

Using this multipart scaling an approximation of a mathematical equation is more precise as
more nodes are used.
A
y
......................................................................................................................................................... i e E]
(x3; y3) + + T (x4; y4) :
______ -+ + 8; 2.5
S L + (&;28)
A
- ,” + N
+ //"‘ (x;y) Interpolation point
/,’l‘/ + + Measured value
- : + Linearized value
#
S+ o
: ; : ; : ; : ; . ; . ; : : —
(x1: y1) - 1 2 3 4 5 6 7 8 X
(0:-0.5) Bt linearization segment 2nd linearization segment 3rd linearization segment
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7.1.5 Calculation

-

ADEBEEERaYREE ABAXANMNGOO R - IPEmation

File Project | Signals | Acquisiion  View  Datamanager  Analysis  Reporting Scripting  Info & 0
= B N SR OR=
= B / O
System |Components| Import  Export Check  Adjust Detect Initialize Display Details
| f)  Caloulation | Access View
v03.51.00.3 [H] Multiple selection... Mame Active | Unit | Phys Min | Phys Max | Sensor Min | Sensor Max | Sampling rate
Mame Z
¥ -3,4028. .. 3,40# 1. Select Signals navigation tab.
4 5 30002367 0 2. Select Calculations.
B  Project settings 0 3. Select Add component >
l CAND1 0 Calculation from the tab menu or
W CANOZ 0 the context menu (right mouse
il CANO3 0 button).
il CANO4 0 4. Activate the calculation.
= DN 4 5. Enter a name and a description in
= Dour 4 the General tab.
g use a —| 6. Enter the calculation in the Formula
ETH 0 | General || Format || Scaling || Display | Formula | L tab.
con o Formula: | "DIN 01" OR "DIN 02°
CoM-2 0
= Audio 0
Display 0
d @ Logger processing 12 |
o Status 11
» Storage groups 0
Mail groups 0
Traffic aroups 1}
Enter the calculation formula
manually or use the Formula editor
L% —
(x).

8. Move signals and operators in the

entry field by using Drag&Drop.

9. Confirm with OK.
|—F{x} 10. Enter the value range and the
— decimals in the Display tab.

11. Define additional limit values and/or

a NoValue.

Calculation rule: 80002367 B x|
"DIN 01" OR "DIM 027 -
Operand Description Reference Source Operator Description |§|
‘DIN 01 : ( Begin of bracket block
DIN 02 Define external trigger (e.g... |DIM 02f800... | 2/DIN/&00 ) End of bracket block
DIN 03 Define external trigger (2.g... |DIN 03/800... | 3/DIN,/S00 |+ Addition
DIN 04 Define external trigger (e.g... |DIM 04/800... | 4/DIN/300 il - Subtraction
DOUT 01 Digital output DOUT 01/8... | 1/DOUT/8( e Multiplication
DOoUT 02 Digital output DOUT 02/8... | 2/DOUT/8( -~ Potentiation
DOUT 03 Digital output DOUT 03/8... | 3/DOUT/3! ! Division
DOUT 04 Digital output DOUT 04/8... | 4/DOUT/S0 » || || MOD Modulo operator
4] m | r ABS() Absolute value -
Define external trigger (e.g. for a storage group). ™

Pool | OK | | Cancel |
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7.2 Digital inputs and outputs

7.2.1 Digital inputs

ATCEEAGYRhL ABXKONGOOE - PEmotion e =
File Project | Signals Acquisition View Data manager Analysis Reporting Scripting In & e|
sy E Q i'i ﬁt_ { 1. Activate the_ Signals tab. _
o o - 2. Select DIN in the system overview.
System Compornents Import Export Check  Adjust Detect Initialize Display I 3. Activate the desired dlgltal inputs.
. : 4. Enter a name and a description in the
Configuration Access
General tab.
(R Name Acive | Unit |PhysMin | Phyd 5. Enter the value to be interpreted as NoValue
Name 2~ in the Format tab. (Value out of the valid
1 range)
4 =1 80002367 0 DIN 02 0 1 6. Enter the value range and the decimals in
=z  Project settings 0 DIN 03 0 f the D|Sp|ay tab.
»l  CAND1 DIN 04 0 1 7. Define the lower and upper limit value with
ol  CAND2 a Limit value.
af  CcAnO3 g 8. Enter the output/display of invalid value with
a CAND4 0 NoValue
& =
8: DOUT 4 General | Format || Scaling | Display | Limit value
g uss 0 .
= 7 Active:
COM-1 0 Mame: |DIN 01
COM-2 0 L -
& Audio B Description:  |Define external trigger (e.g. for a storage group).
& Display 0 Reference: |DIN 01
A @ Logger processing 12| Sampling rate; 1Hz -
@ Status 11
> @ Storage groups 0
@ Mail groups o]
= £
W =
7.2.2 Digital outputs , :
1. Activate the Signals tab.
ETEEBAES VYRt ARXYUOnGOO R - 2. Select DOUT in the system overview.
(e — PR —— 3. Activate the desired digital outputs.
ToJeC Ignals Cquisiaon ew ala manager nalysis £porang Cripung 4 Enter a name and a descr|p’[|0n |n the
wiy {y "hi 't?" { General tab.
=+ v > - 5. Enter the value to be interpreted as NoValue
System Import Export Check  Adjust Detect Initialize Display I in the Format tab. (Value out of the valid
_ _ range)
Configuration Access .
6. Enter the upper and lower acquisition range
V03.51.00,30750 RC Mame Active | Unit | Phys Min | Phyd with Scaling.
MName e 7. Enter the value range and the decimals in
> the Display tab.
4 =1 80002367 20 DOUT 02 0 1 8. Define a formula to control the output with
=z  Project settings [ul DOUT 03 0 1 Calculation.
i CANDI o DOUT 04 0 1 9. Define the lower and upper limit value with
#d  CAND2 Limit value.
»d  CANO3 0
i CAND4 0
8= om 4.
g: General | Format || Scaling || Display | Calculation | Freguency output | Limit value
g uss 0 )
= o Active:
COM-1 0 Mame: |DOUT 01
COM-2 0 — :
i Audio B escription: igital outpu
& Display 0 Reference: |DOUT 01/80002367
F @ Logger processing 12| Sampling rate: 10Hz -
@ Status 11
> @ Storage groups i}
@ Mail groups o]
B eeno £

W B
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Sampling rate DOUT

The logger's digital outputs (DOUT) support
a definable sampling rate (cycle rate) of up
to 100 Hz.

Frequency output DOUT

If the frequency output is activated, a square
wave voltage is sent. The signal frequency
can be configured.

IPEmotion Plugin IPETRONIK-LOG

Gereral | Format | Scaling | Display | Calculation | Frequency output | Limit walue
Bickive:
Marme: DOUT 01
Description:  |Define a command to activate the digital output,
Reference:  |M-LOG (4 CARD
Sarmpling rate: 10Hz =
1Hz
ZHz
S Hz
Z0Hz
S0 Hz
100 Hz
General Formak Scaling Display Calculation Frequency output Lirnit salus
Frequency oukpuk ackive:
Frequency output configuration
Frequency: |10Hz
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7.3 WakeOnCAN

The WakeOnCAN function switches the logger on as soon as the respective CAN bus is active, i.e. when
messages are transferred.

7.3.1 ON via WakeOnCAN, OFF via Ignition 15

If there is no Switch-off time configured, the remote signal (e.g. terminal 15) must be active within the set
timeout to permanently switch-on the logger. The logger is turned off if the remote signal is not received after
the timeout. The logger stays in operation mode as long as the remote signal is high. As soon as remote is
low, the Follow-up time will start and the logger is switched-off when datat postprocessing is finished.

Bridge Pin 3 (CAN2/6-GND) > Pin 6 (PWR-GND) General | Extended | System | Data manager
Bridge Pin 8 (WaOnCAN) -> Pin 9 (UB-OUT+) Sefiziv-em @it (TR

Timeout: |1 min

e =1
& |
f--—____\ :
e® |
o* 1
. : I
USB 1 (isoliert) -
ﬂ_} I
[ I S |
CAN 1+ CANS5
(SubD 9 pol. Stift) i
1=CANE-L
2=CANT-L
I=CANT/G-GND
4=CANE-H
E=Cption (VBATT-IN,CANS WaOnCAN)
F=PWR-GHND
T=CANT-H
B=Option (VBATT-INGAN1 WaOnCAN) _ _ _ _ _
B:LH'OLT"‘ 1
| CAN 2 + CAN 6 ;
| (SubD 9 pol. Stift) I
! 1=CANG-L 1
| 2=CAN2-L |
I 3=CAMNZ/A-GND |
1 4=CANR-H g -
A=A, AR anl Depending on the CAN card/Port replicator, the
[ — E;g-.?fﬁ[f'é N'BE“TT'”LC'"'NE WaOnCAN 'II WakeOnCAN function supports
| T=CANIZ-H | only at CAN 2,
I [ 8=VBATT-IN (CAN2 WaOnCAN) | - at CAN2and CAN3 ,
I g=UB-0OUT+ | - at all CAN inputs (special version)!
|
__________________ 1

7.3.2 ON via WakeOnCAN, OFF via Switch-off condition

With a configured Switch-off condition the Timeout setting has no influence. The logger stays in operation
mode as long as the Switch-off condition is false.

General | Extended | System | Dakta manager

Switch-on condition (WakeonCan: Swikch-off condition: "DIN 01" =1

Timeouk: |1 min

If a temporary remote signal (duration > 1 s) is identified in this mode, the Follow-up time starts
with the falling signal edge and the logger is switched off (when postprocessing is finished),
= | even with a false Switch-off condition.
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7.4 CAN-Send: Output signals to CAN bus

The CAN-Send feature outputs measured signals, calculated channels and status signals using a common
data rate up to 100 Hz. You can use the automatic CAN ID assignment or you may enter individual settings
for each channel. Save the current signal settings to a CANdDb file (*.dbc) for a quick and easy exchange with
the external application using the CANdb export feature.

Requirements: CAN board with FPGA version > 1.04.00
CAN-Send support for one CAN bus of the logger only

At least one CAN participant must be connected to the CAN interface to transfer data to the CAN. If this is
not the case, TESTdrive reports the following:
E Error sending CAN message in CANSendWorkStation. Counter =1

Just after successfully connecting a CAN device data output to the CAN bus is startet, even
when TESTdrive reports “Maximum number of error messages has been reached”.

Creating CAN-Send, Adding channels

’
APEEESAY DD HE e Py
File Project | Signals | Acquisiion  View
4 [ A\ 80002367 3
[N b E Project settings 0
+ - v 4 T Acanot 0
System Components Import Export Check EEAN —
- - > > _1.}._ cano: A B. Components 3 .;\\/ Channels
Configuration '1‘:_" CAN 03 Change into 2
V03.52.00 T canos Exiras .
Name TE Import 3
" Export ]
4 B 80002367 i @, Use as default
[Ed  Project settings 0 J
- Cut Cirl+x
& =
F canoz | B+ Components b || MEE o CAN N Be copy cl4c
3§  CAND3 Change into p (N Paste  Chl+
T cano4 o
L B Extras ’ Standard-CAN Paste behind
= piN M Paste behinc
&= pour 4 Import ar— 3 Delete
'E LSE t EBpot 5 CAN-5end -
ETH
= ool
COM-1 8 Use as defaut - Traffic recording *a Copy to file
COM-2 Cut Cirl+X [5  Paste from file
Audio A
: BEy Copy cCl4C | [ GMLAN £ Properties
[0,  Display
] Logger prod N A— )
e (] GMLAN job-based 1. Highlight a CAN input (CAN 01)
SE Storage s 2. Select Components and then CAN-Send
= pl] st from the tab menu or from the context menu
e r._co. (right mouse button).
A Copy to fil B8 oo 3. Now, the system structure shows the new
e— P entry CAN-Send below the CAN input.
(5 Paste from fie . . 4. Select the channels you want to output to
Multiple selection. ..
i Properties CAN bus.

5. If there are no active channels available,
please activate some first and highlight CAN-
Send. Select Components > Channels from
the tab menu or from the context menu (right
mouse button).
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CAN settings

General | Settings
Sending frequency: |10 Hz -
First CAN ID: (100 h

O

Automatic CAM ID placing:

&

Send counter:

Send counter start bit:

(=

Send counter bit count: |16

Send counter data format: [Intel P

Sending frequency common output rate of all signals: 0.5/ 1/ 2/ 5/ 10/ 20/ 50/ 100 Hz

If the data output rate is greater than or equal to the acquisition rate of source channel, this error report is

written to the log file:
D ERROR in CCANSendWorkStation::Put() Fifo full!

First CAN ID Define the first CAN ID used for automatic CAN ID placing

Automatic CAN ID placing Padding of CAN messages with selected signals and automatic
CAN ID assignment to the respective message

Send counter Counts up the sending tasks

Send counter start bit Start bit used for the send counter value within the CAN message

Send counter bit count Data length of the send counter value

Send counter data format Data format of the send counter value (Intel, Motorola forward)

With automatic CAN ID placing, the first CAN message contains the value of the send counter

(depending on data format byte 1 to 4).

Monitoring the send counter by the receiver is a simple way to verify a correct CAN
communication.

. General | CAN
Ch an n e' S Ettl n g S CAM message: |Message_100
General | CAM CANID: |100 h
Start bit: |16
CANMN message: |Message_100
Bit count: |16
CANID: (100 h
Data format: [i
CAMLSE: |16
Tab view in expert mode
Extended tabs activated under Options > Basic
settings > Expert mode
CAN message Name of the CAN message
CAN ID Identifier of the CAN message (standard ID and extended ID supported)
CAN LSB Start bit within the CAN message of the signal to be output
Extended settings (Expert mode only)
Start bit Start bit within the CAN message of the signal to be output
Bit count Number of bits per signal within the CAN message
Data format Data format of the signal value (Intel, Motorola forward)
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Exporting the settings to a CANdb

Export the current CAN send settings to a CANdDb file after you finished the system configuration. This makes
is easy to configure an external CAN device (notebook, or CAN data display) in order to acquire/display the

signals streamed by the logger.

- = -, - = . = — e r—
AaOEEESES YR AGBXXANMGO0E - Iillﬂlﬂ}
File: Project | Signals | Acquisition  Wiew  Datamanager  Analysis  Reporking  Scriphing Info &« Q
(RS = -4 ﬁ S %
+ =cid Qﬁ 'i' > (>
System  Components  Import Export Check Adjust Detect  Initialize  Cisplay Cietails
Configuration fcess View
¥03.53.00 Channel dex | Active | Unit | Sampling rate | CAMmessage | CAMID [hex] | Start bit
Marne p I 1
¥ [57a01482_1 B °C 10Hz
F S0002367 17 S7e014582_2 2 i 10 Hz Message_100 100 45
Project settings 0 SE700695_1 3 v 100 Hz Message_101 101 0
4§ CAND 7 DIM 01 4 @ 1 Hz Message_101 101 16
4 [ IPETRONIK-CAN g DIM 02 5 1Hz Message_101 101 E
g =ranLdEz 4 Delta T =] iz 10 Hz Message_101 101 43
By S0700655 &) A
4T canoe 6 T lirg m | ¥
- i ol , — .
T canos B Components b 3l | Settings
4 CAND4 @ Changeinto r Sending Frequency: |ID Hz - |
T2 DN
=] i )
£=  pour B Extras 4 First CAM ID: 100 | h
E USE Irnport b |omatic CAM ID placing: ]
ETH | -
o | Export b | CAMdb export
COM-1 = @+ Exporting the Can-Send
= COoM-2 & Use as default configuration to a CANdD
fudio Voot i ] ML Canidb export
L Display — Export of the syskem configuration
4 g Logger processing El_j Copy  ChrHC inko an XML CANdb
Paste  Chrl4y @ IPEmotion Apn export | [ [
. [":) Export configuration For IPEmotion
Paste behind A
pp
K Delete
f;“tg Clean
1. Highlight CAN-Send from the system
JJ‘E] Copy ko File gniig q Y
structure at the left side.
[% Paste from fils 2. Select Export > CANdb export from the
, tab menu or from the context menu (right
ﬁ. Propetties
mouse button)..
3. Select destination and file name (*.dbc) to
save your export.
4. Confirm by clicking the Save button.
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7.5 Log file output via Hyperterminal

The logger status messages can be displayed online with a RS232 PC or notebook connection. The

MLOG.ht file is copied into the following directory:

C:\Documents and Settings\[user]\Startmenu\Programs\Accessories\Communikation\

HyperTerminal\....

Prior to this, a hyperterminal connection must be created.

@ Accessories |fa
| Microsoft Word
» i) IPETRONIK

| ™ &
’;,_ Remote Assistance

Programs
- 4y Documents

Settings

‘ Y Paint

Search

Help and Support

Windows XP Professional

Communications
@ Entertainment
Pl\@ System Tools

'% HyperTerminal

» | & Network Connections

d ? MNetwork Setup Wizard
|5 New Connection Wizard
:Q Remote Desktop Connection

)]

<y Wireless Metwork Setup Wizard

Connect To

Enter a name and choose an icon for the connection:

Mame:
[M-LOG] |

Enter details for the phane number that you want to dial:

Germarny [49]

Ehone number: | |

Country/region;

Area code:

Connect using: | COM1 w |

The following components are required for the
connection of M-LOG and PC:

COM1 Properties

for PCs with serial interface:
1 x USB to RS232 converter

Apply these settings!

1 x Null modem cable

1 x Gender Changer

for PCs without serial interface:
2 x USB to RS232 converter

1 x Null modem cable

1 x Gender Changer

The components for PCs without serial interface are

available as an optional package (M-LOG-OPT-086).

Port Settings | @
- bt §\\/
rd
, ~
Btz per se;oﬁd: |1152DD vl \\
// \
Qata bitz: |8 vl \
! \
I -
| Parity: |None vl
| "
‘Etop bits: |1 vl |
\ 1
FlovMeantal: | [ w /7
\ ’
8 ’
N
S ~ Hestore Efaults
~ — —
[ u]. ] [ Cahcel ] [ Apply

l
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7.6 Send e-mail with status information

If this function is activated and the logger has an internet connection (LAN, WiFi, modem), it sends a status
e-malil after acquisition stop with the following content:

» serial number and number of the current acquisition in subject line,
» attached log file

» attached measurement status file if activated

» attached STG file (Statistic Group, resp. Min-Max list) if activated

IP= Data transfer configuration: 80002367 == ES

General | Medium selection | E-mail

,_.
o
4

Emergency switch-off after:

1. Select the logger in system overview.
File encoding: [ 2. Activate the Data management tab.
Activate data remote transher: Bl 3. Activate the Update connection
parameters > Configuration to change
Time synchronization via SNTP: O

the settings for data transfer configuration.

. Select Activate e-mail delivery.

5. Define the corresponding setting in the E-
Mail tab.

&
I

Activate e-mail delivery:

Import Expart oK Cancel

1Pz Data transfer configuration: 80002367 = || = E
General | Medium selection = E-mail
To: |support@ipetronik, com; info@ipetronik.com; sales @ipetronik, com|

Subject: |Logger [SerialMumber]:Measurement no. {MeasurementId} finished

From:
Logger; [SerialMumber]Measurement; {MeasurementId}Attachment: {Attachment}
Server settings
Server name: Authentication: [
Server IP address: |0.0.0.0 User:
Password:
Import Export QK Cancel
To E-mail address of recipient
Subject Subject line for serial number and mesaurement number file
From E-mail address of sender (any text)
Description field Description of serial number, measurement file number and attachement
Server IP address IPE address of outgoing mail server (to e-mail account,
e.g. smtp.mail.proivder.com) for sending
Server name Alternative input of server name of outgoing mail server
Authentication Access authorization to user e-mail account
User User name
Password Password
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7.7 Output messages to CAN/LIN
With the Logger Plugin V03.21.00 / TESTdrive 3.21 and higher an output of user defined messages to CAN

bus or LIN bus is supported.

The output timing can be selected from:
- one-time, at start measurement,
- one-time, at stop measurement,
- cyclical every x ms.

An external file with the *.DAT extension is used to configure the settings for the messages.

A sample file is available from:

c:\Programs\IPETRONIK\IPEmotion Plugin IPETRONIK LOG V03.xx.xx\Data\Channel.dat

The header of this files contains detailed information regarding to the usage of the parameters.

The screenshots below show the implementation of the external file in IPEmotion configuration.

Expork 3

Cut Chrl+x 2. Select Add components > External

Swstems
Mame Type i b3
A __ 0001469 M-LOG (4 L 20
2 CAN 01 u] 5
| CAMOZ o
i AN O3 u]
s CAM D4 0
8= DM 4
&= Dpout 4
4 LISE u]
= ETH ] =
& Wl P service i [
COM-1 0
COM-2 0
= Audio 0
= Display 0
Daka processing
F  Shatus 1z
@ Local star.., 0
@ Local calc... 0
Swskems
Mame Type A F
- __ 0001469 M-LOG (4 CAM) 20
CAMNO1 u]
w CANDZ 0
: CAN O3 u]
o CAN DG u]
8= D 4
= Dout 4
& use 0
< ETH u]
& [ HCP service i
&= COM-1 0
comM-2 0
= fudio 0
C’l Display 0
< @ [ata processing 12
A Status 12
@ Local storage groups u]
@ Local calculations 0
-m External programs

IPEmotion Plugin IPETRONIK-LOG

B statistic
Add components  » lﬁ External programs
Chanoe inka » } Event handling
Extras Yo [E] Multiple selection. .
ety

oy 1. Select Data processing in the left
e a8 defaul Systems overview.

programs from the tab menu or from the
context menu.

Copty el

Peste 3. The new entry External programs has
Paste behind been added to Data processing.

Delate

Clean

Properties

i ~dd components » & Runtime library

Change into OE] Multiple selection. ..
Extras 3
Import 3
Expart 3
@ Usssdefa | | 4 Select External programs in the left

Systems overview.

Que @l 5. Select Add components > External
Copy  Chrl+C programs from the tab menu or from the
e Y context menu.
6. Chose additional settings in the tab
Paste behind Extended.
Delete
Clean

i3% | Properties
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General | Extended

External library: |6678\DatavChanneldccess.dim (== Remove

Configuration file: | Build 16678\DatalChannel.dat | == Remove Extended (Runtime library)

Message cvcle bime: |10 ms - )
External library

File location of the external application (DLM)

Configuration file
File location of the configuration (DAT)

Message cycle time
Ouput rate of the message (repetition rate)

Example Offset adjust for IPETRONIK modules connected to the logger’s CAN input

The message output feature offers the possibility to broadcast an offset adjust command to IPETRONIK
CAN modules with adjust function.

The sample file OffAddStart.dat contains the adjust commands for task Manual and Group 1-4.
The sample shows a manual adjust on CAN 01 with a baud rate of 500 kBit/s, executed with a time delay of
2.5 seconds from start measurement.

Brief description of the parameters (see header of the sample Channel.dat for detailed settings):
/I Hardware initialization <---Basic setting of CAN/LIN input

[Init]

/I Channel, ChnType, Chnindex, ChnMode, Baudrate

CANO, 1, 0, 1, 500000
<emmeem ChnType LIN=2 /CAN=1, Chnindex Nr 0...11=Input , ChnMode 29Bit=2 11Bit=1/ Baud rate

/I List of messages (send/receive)

[Messages]

/I Name, ID, Length Bytes <------ ID CAN/LIN -ID; Length= Number of bytes; Bytes = Message
1

Manuell_1, 0x0, 8, 0x00, 0x91, 0x02, OXCA, 0x3F, 0x00, 0x80, 0x80 <----Manual
Manuell_2, 0x0, 8, 0x00, 0x91, 0x02, OxCA, 0x3F, 0x00, 0xCO, 0x81

Manuell_3, 0x0, 8, 0x00, 0x91, 0x02, OXCA, 0x3F, 0x00, 0x40, 0x8C

Manuell_4, 0x0, 8, 0x00, 0x91, 0x02, OxCA, 0x3F, 0x00, 0xCO0, 0x8D

Manuell_5, 0x0, 8, 0x00, 0x91, 0x02, OXCA, 0x3F, 0x00, 0x00, Ox8E

Groupl_1, 0x0, 8, 0x00, 0x91, 0x02, 0xC5, 0x3F, 0x00, 0x80, 0x80 <-----Group 1
Groupl_2, 0x0, 8, 0x00, 0x91, 0x02, 0xC5, 0x3F, 0x00, 0xCO, 0x81

Groupl_3, 0x0, 8, 0x00, 0x91, 0x02, O0xC5, 0x3F, 0x00, 0x40, 0x8C

Groupl_4, 0x0, 8, 0x00, 0x91, 0x02, 0xC5, 0x3F, 0x00, 0xCO0, 0x8D

Groupl_5, 0x0, 8, 0x00, 0x91, 0x02, 0xC5, 0x3F, 0x00, 0x00, OX8E

Group2_1, 0x0, 8, 0x00, 0x91, 0x02, 0xC6, Ox3F, 0x00, 0x80, 0x80 <-----Group 2
Group2_2, 0x0, 8, 0x00, 0x91, 0x02, 0xC6, Ox3F, 0x00, 0xCO, 0x81

Group2_3, 0x0, 8, 0x00, 0x91, 0x02, 0xC6, Ox3F, 0x00, 0x40, 0x8C

Group2_4, 0x0, 8, 0x00, 0x91, 0x02, 0xC6, 0x3F, 0x00, 0xCO, 0x8D

Group2_5, 0x0, 8, 0x00, 0x91, 0x02, 0xC6, 0x3F, 0x00, 0x00, OX8E

Group3_1, 0x0, 8, 0x00, 0x91, 0x02, 0xC7, Ox3F, 0x00, 0x80, 0x80 <-----Group 3
Group3_2, 0x0, 8, 0x00, 0x91, 0x02, OxC7, 0x3F, 0x00, 0xCO, 0x81

Group3_3, 0x0, 8, 0x00, 0x91, 0x02, OxC7, 0x3F, 0x00, 0x40, 0x8C

Group3_4, 0x0, 8, 0x00, 0x91, 0x02, 0xC7, 0x3F, 0x00, 0xCO0, 0x8D

Group3_5, 0x0, 8, 0x00, 0x91, 0x02, 0xC7, 0x3F, 0x00, 0x00, OX8E

Group4_1, 0x0, 8, 0x00, 0x91, 0x02, 0xC8, 0x3F, 0x00, 0x80, 0x80 <-----Group 4
Group4_2, 0x0, 8, 0x00, 0x91, 0x02, 0xC8, 0x3F, 0x00, 0xCO, 0x81

Group4_3, 0x0, 8, 0x00, 0x91, 0x02, 0xC8, 0x3F, 0x00, 0x40, 0x8C

Group4_4, 0x0, 8, 0x00, 0x91, 0x02, 0xC8, 0x3F, 0x00, 0xCO0, 0x8D

Group4_5, 0x0, 8, 0x00, 0x91, 0x02, 0xC8, 0x3F, 0x00, 0x00, OX8E
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[Conditions]
/I Name Condition

/l Messages which have to be send at measurement start <---- The output sequence is defined by the
sequence of the list

[OnStart]

/I Time, Channel, Message

2500000, CANO, Manuell_1

<-- 2500000 ps after Start /CAN input/ To adjust a group, replace with Groupl_1
2500000, CANO, Manuell_2

<-- 2500000 ps after Start /CAN input/ To adjust a group, replace with Groupl_2
2500000, CANO, Manuell_3

<-- 2500000 ps after Start /CAN input/ To adjust a group, replace with Groupl_3
2500000, CANO, Manuell_4

<-- 2500000 ps after Start /CAN input/ To adjust a group, replace with Groupl_4

2500000, CANO, Manuell_5
<-- 2500000 pus after Start /CAN input/ To adjust a group, replace with Group1_5

Refer to the header of the *.DAT file for further parameter settings.

7.8 Event controlled measurement
7.8.1 Possibilities for data acquisition

For measurement signal acquisition and storage in electronic systems, analog signals need to be digitalized,
first. This is done by taking discrete measuring values from the continuous signal sequence (Sample & Hold)
and recording them cyclically. Cyclic recording is also used for native digital signals, e.g. for measuring data
packages from bus systems.

For some applications, it is useful to not record CAN bus data cyclically but event-controlled.

In the following, the basic features of both data acquisition types are described.
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7.8.2 Cyclic datarecording of continuous signals

50

45

40

35+

304

25

———+

T T T T T T T T T T
5:06:40  5:08:20  5:10:00  5:11:40 [h:Min:s] 5:15:00  5:16:40  5:18:20  5:20:00  5:21:40

A o
1 SRR

NoValue range ] |
—>

Amplitude
\
A
/

[
>

10 20 30 40 50 60 70 80 90 100 110 120 130 140 150 160 170 Time

T Signal value at sampling point
(equidistant interval)

Features of cyclic data recording (Plugin IPETRONIK-LOG)
» time-based recording in a fixed time grid, e.g. sampling rate 100 Hz
» different storage groups allow different data rates for recording
» individual time channel for each storage group in measurement data set
» continuous recording in equidistant intervals
» suitable for analog signals
» improved time accuracy due to increased sampling rate (oversampling)
» clear comparability of different signals using a synchronization clock (Master Sample Clock MSC)
» protocol measurement during data acquisition using bus systems is possible (CCP, XCP, FlexRay, ...)
» bus signals are allocated to the respective time grid (sampling rate)
» (time) differentiation of two signals is not possible in the time grid

» sampling points without real signal value are indicated with "NoValue" (invalid) in data set
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7.8.3 Event-controlled data recording of bus signals

Sample graph

f e ———

A :
3 o]
2 Wﬁ?‘«;} : ‘ : ‘
- » ~ 12:06,9 12:06,95 12:07  [Mins]  12:07,05
AP %
< | -#?"q?' \ _ﬁ?f ’% .
no signal s ¢
" g Tl
A . ~
875 2125 36.25 45 57.50 67.50 77.50 115 12625 140 15250 166.25 177.50 Time

Signal value with time stamp
from the respective CAN message

Features of event-controlled data recording (Plugin IPETRONIK-LOG)
» event-controlled recording without fixed time grid for bus signals, e.g. CAN bus
» all signals of a message are provided with an exact time stamp, as with traffic measurement
» individual time channel for each message in measurement data set
» discontinuous recording without defined time grid
» suitable for measurement of bus signal differences and of sporadic or single signals

» measuring values in different messages feature different time stamps > in the result graph, the time
stamps do not lie on the same x-values any more

» no protocol measurement possible (CCP, XCP; FlexRay, ... )
» determination of exact time difference between signals (difference between time stamps)

» "NoValue" entries indicating the absence of signals are avoided
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7.8.4 Setting up event-controlled data recording (Plugin IPETRONIK-LOG)
General

Event-controlled measurement, available from TESTdrive 3.51.00 onwards, features the benefits of signal
measurement and traffic measurement:

Signal selection is already interpreted (name, scaling, unit,...). Yet, measurement is not performed cyclically
but with "real" time stamp. Signals are only recorded if they really are present on the CAN bus. Using the
exact time stamp.

Event-controlled measurement appears like a signal measurement on the configuration surface and in the
measurement file. Loggers process the respective storage groups in traffic measurement mode.

Configuration settings

The respective signals must not be recorded cyclically.

-
ATNEHESESYRRL AEXXANGOOR - PEmotion (=[O )
File Project | Signals | Acquisiion  View  Data manager  Analysis  Reporting  Scripting  Info & e
vy X:XCH=
= g 3 1T+ £ i
System Componentz  Import Export  Check  Adjust Detect Inltlallze Display Details

Configuration Access View
¥03.51.00.30750 RC Mame Active | Unit | PhysMin | Phys Max | Sensor Min | Sensor Max | Sampling rate
Mame Z | K54
¥ Pressure_Abs bar 0,00000 2,00000 O 65535 ( Event controlled )
P | 80001358 21 TPS_Valt W -3,0000 |8,0000 1] 65535
@ Project settings [u]
4 3 CcANO1 2
7 oo
FR |
Af  SIM_514005... 2
] CANO2 o]
2 CAND3 0 _
B CAN D4 ol5g
= DIN 4 General | Format || Scaling || Display " Limit value
- bour 4 .
§ us B Active:
ETH 0 MName: |Pressure_Abs |
COM-1 0 -
Description: | |
com-2 o
& Audio [i] Reference: |PI'ESSLII'E_AbS,'IPEI‘I'IE-liE-nDEI‘I]C-.."'C.-‘J\H 01/80001358 |
I:Il isplary ol Maximum rate: |
A @ Logger processing 11
B Status 11
@ Storage groups o]
B e AT
“ iy
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In the storage group, the storage rate has to be set From channel. It should not be a fixed storage rate.

As a result, sampling rate is Event controlled and storage rate is Auto.

P
aDEEESS YR OAEAXAXKONMGOO R IPEmotion
File Project | Signals | Acguision  Wiew  Datamanager  Analysis  Reporting  Scriptng  Info & e
. Bl e o
= a I e/ i 8 e -

System Components Impart  Export Chede  Adjust Detect Initialize Display Details
Configuration Access View
¥03.51.00.30750 RC Channel Storage rate | Index Active | Unit Sampling rate
Mame Z A fi s
» |Pressure_Abs @ [  bar Event controlled
] E IPEmotionDemo L Front_left ] F |cC Event controlled
Ay SIM_51400504_... 2 Front_right Auto F C Event controlled
#d  SIM_51401345_... 1
Af  SIM_50102467_... 2
il CANDZ 0
il CAND3 0
S CAN D4 o
#= DN 4= :
= pout 4 General = Settings | Triggering
¢ uss 0 storage rate( |From channel ) ~ |
ETH o NS
Time stamp channel:
CoM-1 0 ? =
COM-2 0 Movalues: [+
e Audio o Save frigger channel: []
G‘l Display oL_|
F | @ Logger processing 11 Prefic: [
B Status 11
] :':.:_- Storage groups 0
= -
e A
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Measurement file

Event-based signals are recorded in an event-based storage group TS_xxxxxx.DAT. A signal-based storage
group DOxxxxxx.DAT with cyclic storage rate cannot contain event-based signals since event-controlled or
cyclic recording types are properties of signals and not of storage groups.

There are two types DAT files:

»  DOxxxxxx.DAT for storage groups with
cyclic storage rate and signals with fixed,
cyclic sampling rate

P TSxxxxxx.DAT for storagmh\;

event-controlled, non-cyclic signals without
fixed sampling rate

Conclusions

» Each message that is recorded event-
controlled receives an individual time channel

» In DAT format of the logger measurem
each message creates an own internal stor
group (TSxxxxxx.DAT)

» In order to ensure strong system
performance, it is useful to check the number
of event-controlled measuring signals
according to the application (necessary
number of storage groups).

Measurement data set

In table view, it becomes obvious that
time intervals are not equidistant any more and

~c:A\Temp\BAD-IP_26_ 80300023 20130629 114253 MEA_1813.ZIP\"."

e

BAD-IP_26_80900023_20130629_114253_02_Loggerstatus_D0021813
BAD-IP_26_80900023_20130629_114253_02_Loggerstatus_D0O021813
BAD-IP_26_80900023_20130629_114253_02_Loggerstatus_D0021813
BAD-IP_26_80900023_20130629_114253_02_Loggerstatus_D0O021813
BAD-IP_26_80900023_20130629_114253_02_Loggerstatus_D0021813
BAD-IP_26_80900023_20130629_114253_02_Loggerstatus_D0O021813
BAD-IP_26_80900023_20130629_114253_03_Fahrzeugstatus_D0031813
BAD-IP_26_80900023_20130629_114253_03_Fahrzeugstatus_D0031813
BAD-IP_26_80900023_20130629_114253_03_Fahrzeugstatus_D0031813
BAD-IP_26_80900023_20130629_114253_03_Fahrzeugstatus_D0031813
BAD-IP_26_80900023_20130629_114253_03_Fahrzeugstatus_D0031813
BAD-IP_26_80900023_20130629_114253_03_Fahrzeugstatus_D0D31813

BAD-IP_26_80900023_20130629_114253_03_Fahrzeugstatus_D0031813
P26 » I I 04_Vollumfang_getnggert_|
|| BAD-IP_26_80900023_20130629_114253_04_Yollumfang_getriggert_D0041813
|| BAD-IP_26_80900023_20130629_114253_04_Vollumfang_getriggert_D0041813
[ | BAD-IP_26_80900023_20130629_114253_04_Yollumfang_getriggert_D0041813
|| BAD-IP_26_80900023_20130629_114253_04_Vollumfang_getriggert_D0041813
[ | BAD-IP_26_80900023_20130629_114253_04_Yollumfang_getriggert_D0041813
|| BAD-IP_26_80900023_20130629_114253_04_Vollumfang_getriggert_D0041813
|| BAD-IP_26_80900023_20130629_114253_05_GP5_D0051813
|| BAD-IP_26_80900023_20130629_114253_05_GPS_D0051813
|| BAD-IP_26_80900023_20130629_114253_05_GP5_D0051813
|| BAD-IP_26_80900023_20130629_114253_05_GPS_D0051813
|| BAD-IP_26_80900023_20130629_114253_05_GP5_D0051813
|| BAD-IP_26_80900023_20130629_114253_06_Bordnetz_DO061813
[/ BAD-IP_26_80900023_20130629_114253_06_Bordnetz_D0O061813
|| BAD-IP_26_80900023_20130629_114253_06_Bordnetz_DO061813
[/ BAD-IP_26_80900023_20130629_114253_06_Bordnetz_D0O061813
|| BAD-IP_26_80900023_20130629_114253_06_Bordnetz_DO061813
[/ BAD-IP_26_80900023_20130629_114253_07_IPEspeed_komplett_DO071813
|| BAD-IP_26_80900023_20130629_114253_07_IPEspeed_komplett_D0071813
[/ BAD-IP_26_80900023_20130629_114253_07_IPEspeed_komplett_DO071813
|| BAD-IP_26_80900023_20130629_114253_07_IPEspeed_komplett_D0071813
[/ BAD-IP_26_80900023_20130629_114253_07_IPEspeed_komplett_DO071813
|| BAD-IP_26_80900023_20130629_114253_07_IPEspeed_komplett_D0071813
\j BAD-IP_26 80900023 20130629 114253 _08 Temperaturen_Motorraum_DO081813
|| BAD-IP_26_80900023_20130629_114253_08_Temperaturen_Motorraum_DD081813
\j BAD-IP_26 80900023 20130629 114253 _08 Temperaturen_Motorraum_DO081813
P26 . ~ U0l emperatuien_m olonaunm_|

BAD-IP_26 80900023 20130629 114253 08 Temperaturen_ Motorraum DO081813
BAD-IP_Z6_80900023_20130629_114253_09_Ereignisgesteuert_TS010001813
BAD-IP_26_80900023_20130629_114253_09_Ereignisgesteuert_TS010001813

| v

E

DAT 20900
18 5.891
T64 47161
W16 353.76!
W3z 141.50:
wa 53.06/
DAT  67.08:
16 41
R32 4
T64 %
w16 24
Wiz 41
wa 431

6 l
R32 1
T64 l
Wik 1
w3z l
wa 1
DAT 6.85:
R32 43541
T64 12441
W16 18.66I
w3z 6.22(
DAT 1056
(11 47_60:
T64 6347
w3z 31.73
wWa 11900
DAT  21.58
R321.702 27,
T64 141.85(
W16 106.39
Wiz 70.92
W8 42556
DAT 6.93(
6 94 331
Te4 47160

wa 17.681
DAT 2.02
R32 7036

messages (signals) are no more identical. Each | - %401"2- 88000 b s e 0

value is measured and saved at the time it BAD-IP_26_80900023_20130629_114253_09_Ereignisgesteuert_TS010011813 R32  70.34

BAD-IP_26_80900023_20130629_114253 09_Ereignisgesteuert TS010011813 WE4 140,691

actually occurs on the CAN bus. BAD-IP_26_80900023_20130629_114253_09_Ereignisgesteuert_TS010021813 DAT  2.02

| Ereion 7 3 TC{I’I1m')1§!1'-! 229 F2 1
"IBADAP 26 80900023 20130629 114253 09 Ereianisaesteuert TS010021813 W64 144.39.7
Index | TIME Speed_mph_3 Time Speed_mph_2 Time Speed_mph_1
BAD-IP_26_8090,.. BAD-IP_26_80900023_... BAD-IP_26_80... BAD-IP_26_809000... BAD-IP_26_8... BAD-IP_26_B09000...
4934 240,595994 2,53171491622925 246,95334  2,76187086105347 247,633911  2,41663670539856
4935 240,97946 2,53171491622925 247,033392  2,76187086105347 247,688266  2,41663670539856
4936 240,999118 2,53171491622925 247,084021  2,76187086105347 247,738995  2,53171491622925
4937 241,079566 2,41663670539356 247,123929  2,76187086105347 247,760547  2,76187086105347
4933 241,098938 2,416636 70539856 247,173719 | 2,64679265022278 247,348182 2,76187086105347
4939 241,179301 2,41663670539856 247,223519  2,64679265022278 247,88858  2,53171491622925
4940 241,260063 2,30155897140503 247,273564 | 2,64679265022278 247,948201  2,18648099899292
4941 241,289621 2,30155897140503 247,323497  2,64679265022278 247,998492  2,18648099599292
4942 241,318031 2,30155897140503 247,373686  2,64679265022278 248,058395  2,18648099599292
4943 241,389505 2,30155897140503 247,423454  2,64679265022278 245,088545  2,41663670539856
4944 241,41812 2,30155897140503 247473635 2,64679265022275 248,148236  2,53171491622925
4945 241,439817 2,18648099599292 247,52342  2,64679265022278 248,160478  2,30155897140503
4946 241,508455 2,18648099899292 247,573539 | 2,53171491622925 248,248249  2,18648099899292
4947 241,579502 2,18648099599292 247,62349  2,53171491622925 248,268752  2,30155897140503
4943 241,608423 2,18648099599292 24767366 2,53171491622925 248,348459  2,41663670539356
4949 241,679551 2,18648099899292 247,723447 2,53171491622925 249,388811  2,41663670539856
4950 241,708274 2,07140302658051 247,773624  2,53171491622925 248,448397  2,41663670539856
4951 241,779567 2,07140302658081 247,823407  2,53171491622925 248,48874  2,53171491622925
4952 241,806086 2,07140302658081 247,873659  2,53171491622925 248548416 2,64679265022275
4953 241,579497 2,07140302658051 247,923952  2,41663670539356 248,560424  2,B7694883346558
4954 241,908284 2,07140302658081 247,973633  2,41663670539856 249,638883  3,10710477828979
4955 241,979364 2,07140302658081 243,033872  2,41663670539556 248,658384  3,45233845710754
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7.8.5 Practical example: Determination of the latency of two signals
Task

An electronic system (ECU) receives messages via CAN bus (input signals) and sends them out again on
the CAN bus, e.g. as forwarding or after calculation (output signals).

Processing time = response time of the system is to be determined.

CAN IN /]

ID10 ID100 10285 |D9

<CAN OuUT uC

D17 ID17  1D19

! ECU

»

t/us

Realization

The response time results from the time difference between input and respective output signal. Since both
incoming and outgoing CAN messages are provided with a time stamp, the exact time difference can be
determined through event-controlled measurement.

Advantages:
» No event gets lost (not fixed to a sampling rate or to several signals within one sampling interval).
» Unique time stamps from TESTdrive are used.
» Event-controlled measurement is based on traffic measurement > traffic group.

» Each ID generates an event with a new signal value.
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7.9 Data storage

Quick start recording

Depending on the traffic group settings, the Quick start feature records measurement data during the logger
boot-up and between two consecutive acquisitions (previous acquisition is stopped but the following
acquisition is not yet started). The modified function is now providing 3 options:

- Off
- ON

No Quick start recording
Quick start recording during boot-up and between measurements
- Only at start Quick start recording during boot-up only

The second option (Quick start ON) corresponds to the formerly behavior. Selecting Only at start will
record data only during boot-up, not between stop and restart of an acquisition.

fix) Logger processing 0
Md o status 0
SE  Storage groups 0
=E  Mail groups 0
=E  Trafficgroups 0 General | Settings
i
= Traffic group 01 0
o1t Quick start: Off
On
Tj Traffic filter 0
1ol 2 Only at start
= CAND2 0
Yo Traffic filter o
[LINCY
= CANO3 0
Yo Traffic filter o
=1 - e -

.| x
Frequently used Active Title Version Description M
Basic settings In; IPETROMIK CAN 01.14.00.42156 RC Connection of IPETRONIK CAN acquisitio... | IF
Appearance &3 IPETRONIKX 02.01.00 IPETRONIK Ethernet devices IF|
View v mi IPETRONIK LO - (7))
Data manager J‘(r‘*« ) x
Import

@ Options Components
Export i
Analysis e General Detection mode
Maps ~ Activate TESTdrive access restriction: Logger with serial number: 80000000
s
Directories ™ Encoding of the configuration files: * Selection by dislog
All loggers
Units %
1Pz -0 x
Hothkey i Imparting mode
- Video input
User administra
Audio input DIEDE
IPEdoud Copy
FlugIns Aucio output Inguir